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Sissejuhatus 

Täname, et valisite tarkvararakenduse Noxturnal®. Tarkvara Noxturnal on uudne unediagnostika 

tarkvaraplatvorm, mis on loodud kasutamise lihtsustamiseks ja töö tõhustamiseks. Noxturnal tarkvaral on väga 

oluline osa Nox uneuuringuseadme kompleksuses. Selle peamine funktsioon on töötada füsioloogiliste 

signaalidega, mis on salvestatud/saadud ettevõtte Nox Medical seadmetest (vt peatükki Toetatud seadmed) 

ning nendega ühendatud seadmete ja lisatarvikute abil. See võimaldab kasutajal läbida töövoo, mis hõlmab 

salvestuste konfigureerimist, andmete allalaadimist, analüüsimist ja raportite koostamist.  

Ettenähtud kasutus 

Nox uneuuringusüsteemi kasutatakse erinevate unehäirete diagnoosimisel ja unekvaliteedi hindamisel. 

Nox uneuuringusüsteemi kasutatakse une ja ärkvel oleku ajal füsioloogiliste parameetrite mõõtmise, 
salvestamise, kuvamise, organiseerimise, analüüsimise, summeerimise ja saamise eesmärgil üle 2-aastastel 
patsientidel.  

Nox uneuuringusüsteem võimaldab kasutajal valida uuringu keerukuse aste mõõdetavate füsioloogiliste 
signaalide arvu ja tüüpide varieerimise teel. 

Nox uneuuringusüsteem võimaldab luua uuritava andmete põhjal kasutajapõhiseid/eelmääratletud raporteid. 

Nox uneuuringusüsteemi kasutajad on meditsiinitöötajad, kes on saanud väljaõppe haigla- ja kliiniliste 
protseduuride, inimeste füsioloogilise jälgimise või unehäirete uurimise valdkonnas. 

Ettenähtud keskkonnad on haiglad, raviasutused, unekeskused, unekliinikud või muud uuringukeskkonnad, sh 
patsiendi kodu. 

Vastunäidustused 

Nox uneuuringusüsteem ei anna häireid ega ole mõeldud pideva jälgimise jaoks, kus töörike võib põhjustada 
patsiendile vigastusi või patsiendi surma. 

Kohaldusala 

Selles kasutusjuhendis käsitletakse tarkvara Noxturnal kasutamist. Nox seadmete ja nende lisatarvikute, mis on 

vajalikud füsioloogiliste signaalide salvestamiseks, kasutamist on kirjeldatud järgnevates dokumentides. 

• Salvesti Nox A1 kasutusjuhend 

• Salvesti Nox A1s kasutusjuhend 

• Nox C1 pääsupunkti kasutusjuhend 

• Salvesti Nox T3 kasutusjuhend 

• Salvesti Nox T3s kasutusjuhend 

 

See kasutusjuhend hõlmab ka rakenduse Noxturnal ja selle funktsioonide lühitutvustust.  

Hoiatused ja ettevaatusabinõud kasutamiseks  

 Hoiatus. Nox uneuuringusüsteemid EI OLE SERTIFITSEERITUD KASUTAMISEKS PIDEVA 

JÄLGIMISE EESMÄRGIL, kus töörike võib põhjustada patsiendile vigastusi või patsiendi 

surma. 
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 Hoiatus. Nox uneuuringusüsteemid on ette nähtud unehäirete diagnoosimise 

töövahenditena. Neid süsteeme tuleb kasutada koos teiste kliiniliste tunnuste ja 

sümptomite hindamise meetoditega. 

 Märkus. Automaatne analüüs võib olla vähem täpne kui väljaõppe saanud arsti tehtud 

analüüs. Automaatset analüüsi/skoorimise tulemust peab enne diagnoosi panemist alati 

manuaalselt kontrollima väljaõppe saanud arst. 

 Hoiatus. Tuletatud signaalide arvutamine rakendusega Noxturnal, eriti EKG ja 

respiratoorse pingutuse signaalide põhjal südamelöögisageduse ning hingamissageduse 

arvutamine, pole heaks kiidetud patsientide puhul, kellel on diafragma/vahelihasenärvi 

stimulaator. 

 Hoiatus. Salvesteid Nox A1, A1s, T3 ja T3s ei tohi mitte mingil juhul ühendada arvuti USB-

porti, kui need on patsiendiga ühendatud. Selle tulemusel võib patsient saada elektrišoki 

või raskeid vigastusi. 

 

 Palun lugege enne kasutamist hoolikalt kasutusjuhendit, eriti hüüumärgiga 

tähistatud lõike. 
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Tarkvara Noxturnal kirjeldus  

Tarkvara Noxturnal vahetab andmeid Nox salvestusseadmetega ja Nox pääsupunktidega. See võimaldab nii 

nende seadmete konfigureerimist kui ka Nox seadmete salvestatud / vastu võetud füsioloogiliste signaalide 

kuvamist, navigeerimist, organiseerimist, analüüsimist, raporteerimist, arhiveerimist ja esitamist. Selles 

jaotises kirjeldatakse peamisi rakenduse funktsioone ja installeerimisjuhiseid. 

Rakenduse Noxturnal kirjeldus  

Rakendus Noxturnal on Androidi rakendus, mida kasutatakse mobiilse liidesena salvestite  Nox A1 ja 
pääsupunktide Nox C1 puhul. Rakendus võimaldab kasutajal täita konkreetseid tarkvara Noxturnal puhul juba 
teadaolevaid ülesandeid paindlikumalt ja patsiendisõbralikumalt.  
Rakenduse funktsioonid on järgmised: 

 

• ambulatoorsete salvestuste 
konfigureerimine; 

• rakenduses Noxturnal konfigureeritud 
online'is jälgitavate tubadega ühendamine; 

• signaali kvaliteedi hindamine; 

• takistuse kontrollimine; 

• biokalibreerimine; 

• salvestamise alustamine ja lõpetamine; 

• online'is tehtud salvestuste oleku vaatamine 
(Recording, Standby, Not Prepared 
(Salvestamine, Ootel, Ei ole ette 
valmistatud)).  

 

Rakenduse alla laadimiseks skannige eespool esitatud QR-kood või otsige märksõnaga „Noxturnal" Google Play 

poest. Rakendus töötab mobiilseadmetes, milles on Androidi versioon 8.0 või uuem. 

Toetatud seadmed 

Noxturnal toetab järgmisi Nox seadmeid ja nendega seotud seadmeid ja tarvikuid: 

• Salvesti Nox A1 

• Salvesti Nox A1s 

• Nox C1P pääsupunkt 

• salvesti Nox T3; 

• salvesti Nox T3s. 

Selles kasutusjuhendis kasutatakse Nox salvestit üldnimetusena salvestite Nox A1, Nox A1s, Nox T3 ja Nox T3s 

jaoks. 

Selles kasutusjuhendis nimetatakse salvesteid Nox T3 ja Nox T3s ühiselt Nox T3 salvestiteks. Samamoodi 

nimetatakse salvesteid Nox A1 ja Nox A1s ühiselt Nox A1 salvestiteks. 

Tarkvara Noxturnal installimine  

Enne tarkvara Noxturnal installimist vaadake üle süsteeminõuded, mis on vajalikud tarkvararakenduse 

kasutamiseks. 
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Tarkvara Noxturnal süsteeminõuded 

 

 Märkus. Kasutatav arvuti peab vastama rahvusvahelisele standardile IEC 60950-

1 infotehnoloogiaseadmete ohutuse kohta. 

 Märkus. Arvutisse, millega kasutatakse Noxturnal tarkvara, on soovitatav 

installida viirusetõrje. 

Järgnevas tabelis on esitatud minimaalsed riistvaranõuded, mis on vajalikud tarkvara tõhusaks installimiseks ja 

sellega töötamiseks. 

Minimaalsed süsteeminõuded 

Riistvara tüüp Miinimumnõuded 

Operatsioonisüsteem Windows 10 

Protsessor 64-põhine Intel või AMD 

Protsessori taktsagedus 1,7 GHz või kiirem 

Mälu 2 GB või rohkem 

Vaba kõvakettaruum 4 GB või rohkem 

Graafika lahutusvõime 1024 x 768 või suurem 

Süsteemi seadistamiseks online keskkonnas kehtivad eespool loetletud minimaalsed süsteeminõuded. Iga 

online süsteemi jaoks on tungivalt soovitatav kasutada eraldi arvutit. Ent kogenud asjatundjatel on võimalik 

töötada rohkem kui ühe süsteemiga arvuti kohta. 

On soovitatav rakendada head IT-tava, näiteks: 

• kontrollige juurdepääsu arvutile, millel süsteem töötab; 

• kehtestage salasõnale esitatavad nõuded; 

• uuendage arvuti operatsioonisüsteemi regulaarselt; 

• järgige tarkvara Microsoft Windows kasutuskuupäeva lõppu; 

• installige viirustõrjeprogramm; 

• kasutage arvutit ainult kliinilistel eesmärkidel; 

• varusalvestiste asukoht – Noxturnal ei tegele andmete varukoopiate tegemisega. 

Märkus. Ühenduste puhul välissüsteemidega nagu Nox Cloud, GDT või HL7, käitub Noxturnal nagu klient ja 

toetub olemasolevatele süsteemi turvaseadistustele. 

Installimisjuhised 

• Veenduge, et oleksite süsteemi sisse logitud administraatorina. 

• Leidke installimise CD-l või installimisveebilehel fail nimega Setup.exe ja käivitage see. 

• Avaneb viisard, mis juhendab kasutajat installimise ajal. Järgige juhiseid rakenduse installimiseks. Kui 

uuendate versioonilt Noxturnal 5.x, toimub taustal uuendusprotsess. Rakenduse kasutajaseadete 

uuendamine. Enne uuendamise alustamist salvestatakse seadete koopia asukohta „[Minu 

dokumendid]\NoxturnalUpgrade".    
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 Teabe saamiseks kõige uuema tarkvaraversiooni ja uuenduste kohta pöörduge 

edasimüüja poole. Edasimüüja kohta saate teavet veebilehelt: 

www.noxmedical.com. 

 Töötoe, kasutajavigade, küberturbe juhtumite või muude juhtumitega seotud 

küsimuste korral võtke ühendust meiliaadressil support@noxmedical.com 
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Tavapärane töö 

Rakenduse Noxturnal käivitamiseks tehke topeltklõps töölaual oleval ikoonil või klõpsake Windowsi Start-

menüüs rakenduse ikoonil. Rakenduse sulgemiseks klõpsake märki X üleval paremas nurgas või valige menüüs 

File (Fail) Exit (Välju). 

Kui rakendus Noxturnal käivitub, kuvatakse töökeskkond. Kui seade on ühendatud, näete seda pildil, vastasel 

juhul seadet ei kuvata. Selles dokumendis on ühendatud salvesti Nox T3, nagu pildil näha. 

 

Lehel Recording (Salvestamine) saab kasutaja töötada Nox seadmete ja neid seadmeid kasutades salvestatud / 

vastu võetud andmetega. Sellel lehel juhendatakse kasutajat kõige tavalisemates ülesannetes, mida 

rakendusega on võimalik teha. Need on järgmised. 

• Library (Teek). Seda valikut näete vasakul ülanurgas. See valik avab salvestiste teegi. Teegis on loend 

kõikide salvestistega, mis on kas salvestatud, alla laaditud või salvestiste teeki manuaalselt lisatud. 

Üksikasjalikumat teavet vt jaotisest Salvestiste teek. 

• Configure Device (Seadme konfigureerimine). Valige see valik, et alustada uut ambulatoorset 

salvestust. Avaneb konfigureerimise viisard, mis juhendab kasutajat konfigureerimise ajal. 

Üksikasjalikumat teavet vt jaotisest Uue ambulatoorse salvestuse käivitamine. 

• Download Recording (Salvestise allalaadimine). Kui ühendatud on salvestist sisaldav salvestusseade, 

saab kasutaja salvestise alla laadida ja üle vaadata. Üksikasjalikumat teavet vt jaotisest Ambulatoorse 

salvestise allalaadimine Nox salvestusseadmest.  

Online'is salvestamise konfigureerimiseks tuleb eelkonfigureerida oneline'is jälgitav tuba, seejärel ilmub see 

valitavana salvestamise lehele. Oneline'is tehtava salvestuse konfigureerimise juhiseid vt jaotisest Nox 

unesüsteemi seadistamine oneline'is salvestamiseks.  



rakenduse Noxturnal kasutusjuhend 

   

~ 12 ~ 

Nox salvestusseadme ühendamine tarkvaraga Noxturnal  

 

 Märkus. Palun pange tähele, salvestusseade on soovitatav väljutada enne selle 

arvutist lahti ühendamist. Siiski võib seadme ühenduse katkestada ka ilma 

väljutamata. 

Tarkvara Noxturnal kasutatakse Nox salvestusseadmetest saadud andmete konfigureerimiseks ja alla 

laadimiseks. Salvestusseadmega töötamiseks ühendage see kõigepealt USB-kaabli abil arvutiga. Noxturnal 

tuvastab automaatselt seadme ja kuvab teavet seadme kohta. Tuvastamine võib võtta 2–4 sekundit. 

Kui Noxturnal tuvastab ühendatud seadme, kuvatakse seadme kohta järgmine teave: salvestamise olek, 

püsivaraversioon ja seadme nimi.  

Salvestusseadmel tehtavad ülesanded olenevad seadme olekust, mis võib olla järgmine. 

• Empty (Tühi) – seade pole konfigureeritud või ei sisalda salvestisi. Seadme konfigureerimiseks uue 

salvestuse jaoks klõpsake Configure Device (Konfigureeri seade). Pange tähele, et seadme 

konfigureerimine kustutab seadmest kõik olemasolevad salvestised. 

• Ready to Record (Valmis salvestuseks) – seade on konfigureeritud, kuid ei sisalda salvestisi. Selles 

olekus võib kasutaja seadme lahti ühendada ja salvestamisprotsessi käivitada. 

• Ready to Download (Valmis allalaadimiseks) – seade sisaldab salvestist, mida pole arvutisse laaditud. 

Klõpsake nupul Download Recording (Laadi salvestis alla), et salvestis arvutisse laadida. 

• Download Complete (Allalaadimine valmis) – seade sisaldab juba alla laaditud salvestist, mis on 

salvestiste teeki lisatud. Selles olekus võib kasutaja seadme konfigureerimiseks klõpsata Configure 

Device (Seadme konfigureerimine), et salvestada teine salvestis, või klõpsata Download Recording 

(Salvestise allalaadimine), et salvestis uuesti alla laadida. 

Kui olete seadmega töötamise lõpetanud, klõpsake lingil Eject (Väljutamine) ja ühendage seade arvuti küljest 

lahti. 

Salvestusseadme püsivara uuendamine 

 

 Märkus. Pärast püsivara uuendamise teatel klõpsamist peate salvestusseadme 

arvutist lahti ühendama ja seejärel uuesti ühendama, et oleks võimalik seadme 

püsivara uuendada. 

 Märkus. Alati on soovitatav teha seadme püsivara uuendus tagamaks, et Nox 

salvesti töötab uusima püsivara versiooniga. Uued püsivaraversioonid võivad 

sisaldada salvesti tööks olulisi uuendusi.  

Kui ühendatud seadmele on olemas uus püsivaraversioon, annab Noxturnal sellest kasutajale märku seadme 

kõrval teateakna kuvamisega. See on seadmest sõltumatu ja näete sellel lehel seadme tüüpi olenevalt 

ühendatud seadmest. Sellel pildil on ühendatud Nox T3 salvesti. 
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Valige kas teate eiramine ja jätkake tööd või uuendage seadme püsivara, mis on alati soovitatav. 

Uuendamiseks klõpsake teateaknalUus püsivara saadaval ja järgige antud juhiseid. 

Uue ambulatoorse salvestuse alustamine  

Salvestusseadme uueks salvestuseks ette valmistamiseks käivitage rakendus Noxturnal ja ühendage seade 

USB-kaabli abil arvutiga. Noxturnal tuvastab seadme automaatselt ja kuvab seadme teabe lehel Recording 

(Salvestamine). Klõpsake nupul Configure Device (Seadme konfigureerimine) lehel Recording  (Salvestamine) 

ning avaneb viisard, mis juhendab kasutajat seadme konfigureerimisprotsessis. 

Konfigureerimise viisard sõltub seadmest. See tähendab, et konfigureerimise viisard erineb olenevalt 

konfigureeritavast Nox salvestist. Kuid põhietapid on alati samad. 

1. Seadme konfigureerimine. kust valite salvestustüübi (võimalikud ühendatud lisaseadmed ja kanalid, 

mida salvestatakse). 

2. Salvestuse ajastamine, kust saate valida salvestuse alguse kellaaja ja kuupäeva või patsient käivitab 

salvestuse ise sobival ajahetkel. 

3. Patsiendi andmed, kust saate salvestusele lisada vajalikud patsiendi andmed. 

Selles kasutusjuhendis on esitatud salvesti Nox T3 konfigureerimise viisard. Esimesena tuleb määrata, millist 

salvestustüüpi salvestuseks kasutada. Salvestustüüpidel on kirjeldavad nimed, et näidata, millisteks 

salvestusteks neid kasutada. 

Vt jaotist Salvestustüübid ja seadmeprofiilid, et saada lisateavet salvestustüüpide ja seadmeprofiilide loomise 

ning redigeerimise kohta. 
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Kui teie salvestustüüp on määratud andmeid salvestama Bluetooth-seadme,  nt pulssoksümeetri kaudu, näete 

seda konfigureerimise viisardis. Et kasutada Bluetooth-seadet, tuleb see Nox salvestusseadmega ühendada. 

Sisestage konfigureerimise viisardi vastavale väljale õige Bluetooth-seadme pin-kood/BDA (Bluetooth-seadme 

aadress).  

Mõnede seadmete puhul on vajalik seadme ühendamine kasutatava oksümeetriga. Pärast oksümeetri BDA-

aaddressi sisestamist klõpsake nupul Pair with Oximeter (Oksümeetriga sidumine) ja oodake vastust. Pange 

tähele, et selle toimingu sooritamisel tuleb oksümeeter sisse lülitada, vajutades oksümeetri nuppu. Järgige 

ekraanile ilmuvaid juhiseid.  

Klõpsake Next (Järgmine), et liikuda edasi etappi, kus määratakse salvestuse kellaaeg. 
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• Kui on märgitud suvand By Connecting Nox RIP Belts (Start on Belt) (Ühendades NOX RIP-vööd 

(Alusta vööl)), algab salvestamine, kui kasutaja ühendab Nox RIP-vööd Nox salvestusseadmega. Selle 

suvandi kestus on Unspecified (Pole määratletud), kuna salvestamine peatub, kui ühendate vöö 

salvesti küljest lahti. Funktsioon on saadaval ainult Nox T3s ja A1s seadmete jaoks, millel on püsivara 

3.1.0 või uuem. 

• Kui valik By Pressing button (Manual) (Salvestuse alustamine nupuvajutusega (manuaalselt)) on 

märgitud, vastutab kasutaja Nox salvestusseadmes salvestamise alustamise/peatamise eest. Seda on 

võimalik teha seadmel oleva nupu Push (Vajuta) vajutamise ja allhoidmise teel, kuni seadme ekraanil 

kuvatakse, et salvestamine on alanud. 

• Märkige suvand At Scheduled Date: (Ajastatud kuupäeval:) kindla salvestusaja ajastamiseks. Seade 

lülitub sisse ja hakkab ette määratud ajal automaatselt salvestama. Kui kasutaja soovib salvestada 

rohkem kui ühe öö jooksul, algavad salvestused igal õhtul samal ajal. 

• Salvestamise peatamiseks pärast teatud perioodi, määrake Duration (Kestus): 7 Hours (7 tundi), 8 

Hours (8 tundi), 10 Hours (10 tundi) või sisestage kohandatud kestus. Kui on valitud Unspecified (Pole 

määratud), vastutab salvestamise peatamise eest kasutaja. Seda tehakse seadmel nupu Push (Vajuta) 

vajutamise ja all hoidmisega, kuni seadme ekraanil kuvatakse, et salvestamine on peatunud. 

Klõpsake Next (Järgmine), et liikuda kolmanda etapi juurde, milleks on patsiendi andmete sisestamise 

dialoogiaken. Sellesse dialoogiaknasse on võimalik sisestada patsiendi üksikasjalikke andmeid. Ainuke 

kohustuslik väli on patsiendi nimi või ID.  
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Pärast patsiendi andmete sisestamist klõpsake Finish (Lõpeta), et konfiguratsioon seadmele esitada.  

Juhul, kui seadmes on salvestis, küsitakse kasutajalt, kas ta soovib salvestise seadmest kustutada. 
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Viimasena kuvatakse kinnitamise leht, mis teatab seadme konfigureerimisest. Salvesti Nox T3 puhul saab 

seadme paigaldamise juhendi printida nupule Print Hookup Instructions (Seadme paigaldamise juhendi 

printimine) klõpsates. Avatakse PDF-dokument seadme paigaldamise joonistega, mida saab printida. Kui 

seadme paigaldamise juhised pole saadaval, ei kuvata seda valikut. 

   

Salvestustüübid 

Rakendusega Noxturnal on nii ambulatoorsete kui ka online'is salvestamise konfigureerimiseks saadaval hulk 

salvestustüüpe. Salvestustüübid hõlmavad seadme kombinatsiooni, mida kasutatakse erinevateks 

uneuuringuteks ja seadme seadistusteks. Salvestustüübid määravad ka erinevate salvestuste 

automatiseerimise, asjakohase töökeskkonna kujunduse, analüüsi ja raporti tüübi, mida salvestusega 

kasutatakse. Rakenduses Noxturnal saate seadmete juhtimiseks ja salvestuste seadistuste määramiseks luua 

hõlpsalt meelepärased salvestustüübid. Järgige neid etappe, et luua isikupärastatud salvestustüüp.  

1. Valige salvesti Nox, millele te salvestustüübi loote, ja kas selle eesmärgiks on ambulatoorne või 

online'is salvestamine 

2. Seadistage salvestustüüp, et lisada sobiv töökeskkonna kujundus, analüüsimine ja uuringutulemuste 

raport, seadmed ning seadmeprofiilid. 

Salvestustüübi viisard sõltub seadmest. See tähendab, et viisard erineb olenevalt konfigureeritavast Nox 

salvestusseadmest. Kuid põhietapid on alati samad. 
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Rakenduse Noxturnal tööriistaribalt liikuge järgmiselt: Devices > Recording Types… (Seadmed > 

Salvestustüübid...)  

 

Avaneb salvestustüüpide viisard. 

  

  

Siin saate luua salvestusüübi New (Uus), olemasolevatel salvestustüüpidel põhineva New Based On (Uus ... 

põhinev), redigeerida, valides Edit (Redigeerimine), või eemaldada kohandatud salvestustüübi, valides Remove 

(Eemaldamine). Näiteks loome salvestile Nox T3 uue salvestustüübi.  

Valige rippmenüüst salvestustüüp Nox T3 (ambulatory) (Nox T3 (ambulatoorne)), nagu on näidatud allpool. 
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Järgmisena tuleb kasutatav salvestustüüp seadistada. Järgnevas viisardis saate salvestustüübi seadistada.  
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Sisestage väljale Recording Type Name (Salvestustüübi nimi) salvestustüübi nimi ja väljale Description 

(Kirjeldus) salvestustüübi kirjeldus. Valige sobiv Workspace Layout (Töökeskkonna kujundus), Analysis 

(Analüüs) ja Report (Raport). Saate lisada ka lisaseadmeid. Valige näiteks Nonin 3150 (jaotisest Device Types 

(Seadmetüübid)) ja klõpsake Add>> (Lisa>>). 

 

Pange tähele, et otse salvestustüübi viisardist saab sellele salvestustüübile valida ka sobiva seadmeprofiili, vt 

allpool.  
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Saate luua ka kohandatud seadmeprofiile, täpsemaid juhiseid vt jaotisest Seadmeprofiilid. Kui olete uue 

seadmeprofiili loonud, ilmub see salvestustüübi viisardi ripploendisse. 

Kui olete salvestustüübi seadistanud, klõpsake OK ning teie kohandatud salvestustüüp on konfigureeritav.  

Seadmeprofiil id 

 

 Märkus. Seadmeprofiilide viisardid on erinevate Nox salvestusseadmete puhul 

erinevad. 

Seadmeprofiilid luuakse kõigile tavapärastele salvestustele, mida te Nox seadmetega teha võite. Need 

võimaldavad seadme konfigureerimise ajal lihtsat seadistamist. 

Rakenduse Noxturnal tööriistaribalt navigeerige asukohta Devices > Device Profiles… (Seadmed > 

Seadmeprofiilid...) 
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Seadmeprofiilide viisardis näete Nox salvestusseadmete ja Nox pääsupunkti jaoks saadavalolevate 

seadmeprofiilide loendit. 

 

Uue kohandatud seadmeprofiili loomiseks valige New (Uus) või New Based On (Uus... põhinev). Seejärel peate 

valima, millisele salvestusseadmele loote malli või milliste olemasolevate seadmeprofiilide põhjal te soovite 

uut malli luua. Näiteks loome salvestile Nox T3 uue seadmeprofiili. 
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Profiili omaduste viisardis saate seadmeprofiili seadistada. Sisestage nimi (ja kui soovite, siis kirjeldus).  

  

Klõpsake Next (Järgmine), et liikuda järgmisesse etappi. 

Allpool olevas dialoogiaknas saate seadistada seadmega kasutatavate kanalite konfiguratsiooni. Seadme 

konfiguratsiooni dialoogiaken sõltub seadmest. See tähendab, et viisard erineb olenevalt kasutatava Nox 

seadme tüübist. Kui olete kanali konfiguratsiooni seadistanud, klõpsake Next (Järgmine). 
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Konfigureerimise viimases etapis tuleb määrata, millist tüüpi patareid salvestusseadmes Nox kasutatakse. 

Valige sobiv patareitüüp ja klõpsake Finish (Lõpeta). 
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Loodud seadmeprofiil on leitav seadmeprofiilide loendis ja valmis konfigureerimiseks.  

Ambulatoorse salvestise allalaadimine Nox salvestusseadmest  

 

 Märkus. Allalaadimise osaline nurjumine mis tahes põhjusel, võib anda 

ebaselgeid salvestustulemusi. Kasutajat hoiatatakse, kui see juhtub, ning ta 

peab otsustama, kas salvestatud andmed on täielikud või mitte. Seadmest on 

võimalik andmed uuesti alla laadida. 

 Märkus. Allalaaditud salvestist ei kustutata seadmest enne, kui seade 

konfigureeritakse järgmise salvestamise jaoks. 

Salvestatud andmete allalaadimiseks Nox salvestusseadmest arvutisse veenduge, et Noxturnal töötab ja 

seejärel ühendage seade arvuti USB-pordiga. 

Noxturnal tuvastab seadme automaatselt ja kuvab seadme teabe lehel Recording Page (Salvestamise leht). 

Tuvastamine võib võtta 2–4 sekundit. 

Klõpsake nupul Download Recording (Salvestise allalaadimine) lehel Recording Page (Salvestamise leht) ja 

Noxturnal alustab salvestise allalaadimist seadmest arvutisse. Ilmub allalaadimise edenemise dialoogiaken, mis 

kuvab allalaadimise ajal asjakohased etapid. Esmalt laaditakse andmed alla, seejärel käivitatakse analüüsi 

vaikimisiprotokoll ning kui seade oli konfigureeritud heli salvestama, algab heli allalaadimine.  

  

Pärast allalaadimise lõppu teavitatakse kasutajat ja ta saab hakata töötama kogu salvestisega. 

Salvestised laaditakse alati andmete vaikimisi hoiukohta. Andmete vaikimisi hoiukohta on võimalik muuta 

tööriista valiku dialoogiakna automatiseerimise vahelehel (Tools → Settings… → General) (Tööriistad → 

Sätted... → Üldine). Allalaaditud salvestised lisatakse automaatselt salvestiste teeki ja neid on võimalik igal ajal 

vaadata, minnes salvestiste teeki ja neid avades. Üksikasjalikumat teavet vt jaotisest Salvestiste teek.  
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Nox uneuuringu süsteemi seadistamine online'is salvestamiseks  

Online süsteemi võrgu ülevaade  

Nox uneuuringu süsteemi veebis salvestamise funktsiooni ühtlase töö tagamiseks järgige allpool esitatud 

soovituslikku süsteemi seadistust.  

• Iga online süsteemi jaoks on soovitatav kasutada eraldi arvutit. Siiski saab ühel arvutil kasutada 

rohkem kui ühte online süsteemi, üksikasju vt jaotisest Minimaalsed süsteeminõuded.  

• Kasutage eraldi kohtvõrku (LAN) iga Nox C1 pääsupunkti ja tarkvaraga Noxturnal töötava arvuti jaoks. 

• Kasutage iga rakendatava Nox A1 salvesti jaoks eraldi Nox C1 pääsupunkti. 

Allpool toodud tabelis on esitatud kontrolltoa seadistus, kus asub arvuti koos tarkvaraga Noxturnal.  

Kontrolltuba 

Üksus Ühendus 

Arvuti 
Ühendatud võrgukaabli abil Nox C1 

pääsupunktiga samasse võrku 

Noxturnal Installitud arvutisse 

Allolevas tabelis kirjeldatakse patsiendituba, kus patsient uneuuringu ajal magab. 

Patsiendituba 

Üksuse nimi Kirjeldus Funktsioon Seadistus/ühendus 

Nox C1P 
pääsupunkt 

Analoog- ja 
jadasisendite, 
sisseehitatud 
valgusanduri ja 
diferentsiaalrõhu 
anduriga Bluetooth-
pääsupunkt 

 Bluetooth-ühenduse 
kaudu seadmelt Nox 
A1 saadud ja Etherneti 
kaudu rakendusse 
Noxturnal edastatud 
andmed 

 Rakendusega 
Noxturnal Etherneti 
kaudu vastu võetud ja 
Bluetooth-ühenduse 
kaudu Nox A1 
edastatud käsud 

 Analoog- ja 
jadasisenditega 
ühendatud 
lisaseadmetest vastu 
võetud ja Etherneti 
kaudu rakendusse 
Noxturnal edastatud 
andmed 

Asub patsiendiruumis. 
Ühendatud sama LAN-
iga, nagu arvuti, millel 
tarkvara Noxturnal 
töötab 

Salvesti Nox A1 ja 
sobivad andurid 

Salvestusseade, mis 
võib olla 
konfigureeritud 
erinevat tüüpi 
uneuuringuteks 

Salvestab sisseehitatud ja 
ühendatud anduritelt 
saadud füsioloogilisi 
signaale 

Ühendatud 
patsiendiruumis oleva 
patsiendiga 
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Meditsiinilised 
lisaseadmed 

Mis tahes 
meditsiiniseade, mis 
vastab Nox C1 
pääsupunkti 
sisendkanali 
spetsifikatsioonidele. 
Meditsiiniseadmed, 
mida toetab süsteem, 
mis ühendatakse 
salvestiga Nox A1 
Bluetooth-lingi kaudu 

Oleneb kasutatavast 
lisaseadmest 

Nox C1 pääsupunkti 
analoog-
/jadasisendiga 
ühendatud sobiv 
ühenduskaabel 
Bluetooth-lingi kaudu 
salvestisse Nox A1 

Rakendus 
Noxturnal 

Androidi rakendus  

Saab kasutada veebis 
jälgitavate tubade 
ühendamiseks, signaali 
ülevaatamiseks ning 
biokalibreerimiseks ja 
takistuse kontrollimiseks. 
Saab kasutada ka 
salvestamise alustamiseks 
ja lõpetamiseks 

Seadke rakendus 
online režiimi ja 
ühendage sobiva 
online'is jälgitava 
toaga 

Allpool oleval joonisel on esitatud Nox uneuuringu süsteemi online'is seadistamise ülevaade.  

  

Nox C1 pääsupunkti kasutab tarkvara Noxturnal.  

Nox C1 pääsupunkti ja salvesti Nox A1 kohta täiendavate juhiste saamiseks vaadake Nox C1 kasutusjuhendit 

ning Nox A1/A1s kasutusjuhendit.  

Etherneti toetatud seadmete ja Nox unesüsteemi puhul valideeritud ruuterite kohta vaadake jaotist 

„Ühilduvad seadmed". 
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Online süsteemi konfiguratsioon 

Selles peatükis kirjeldatakse, kuidas seadistada Nox uneuuringu süsteemi online konfiguratsiooni. Esmalt 

veenduge, et oleks paigaldatud kõik vajalikud seadmed ja lisaseadmed, nagu Nox C1 pääsupunkt, Etherneti 

kaablid ja ruuter. Lisateavet võrgu, sh Nox C1 pääsupunkti, seadistamise kohta vt Nox C1 kasutusjuhendist.  

Nox uneuuringusüsteemi seadistamiseks veebipõhisesse konfiguratsiooni tuleb rakenduses Noxturnal läbida 

järgmised etapid. 

1. Seadistage Online Rooms (online'is jälgitavad toad) 

2. Konfigureerige uued Sensors (Andurid) 

3. Seadistage Device Profiles (Seadmeprofiilid) 

4. Seadistage Recording Types (Salvestustüübid) 

Neid etappe kirjeldatakse allpool. Nende etappide läbimine võimaldab alustada online'is salvestamist ja 

seejärel alustada rakenduses Noxturnal tööd signaalidega. 

Online'is jälgitav tuba 

Online'is jälgitava toa seadistamine on osa rakenduse Noxturnal online'is salvestamise seadistamisest. Veebis 

jälgitav tuba hõlmab seadmete kogumit, mida hoitakse tavaliselt ühes toas. Need võivad näiteks olla kõik 

seadmed, mida hoitakse spetsiaalses uneuuringute jaoks mõeldud haiglaruumis.  

Uue toa lisamiseks valige rakenduse Noxturnal tööriistaribalt Devices > Online Rooms… (Seadmed > Online'is 

jälgitavad toad...). See avab dialoogiakna Rooms (Toad). 
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Siin saate lisada uue toa või redigeerida olemasolevat tuba. Uue toa lisamiseks klõpsake Add Room (Toa 

lisamine) ning allolevas dialoogiaknas saate uuele toale anda nime, kui klõpsate pliiatsi ikoonile, ja lisada toa 

seadmeid, kui klõpsate Add Devices (Seadmete lisamine). 

 

 

Viisardis Add Devices (Seadmete lisamine) saate oma tuppa lisada seadmeid. Seadme lisamiseks valige loendist 

Device Types (Seadmetüübid) sobiv seade ja klõpsake Add >> (Lisamine) või tehke loendis seadmel 

topeltklõps. Saate otsida teie võrku ühendatud IP seadmeid klõpsates Scan for IP Devices (IP-seadmete 

otsimine). 
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Kui lisate salvesti Nox A1, peate valima sobiva Nox C1 pääsupunkti, mida toas kasutatakse, ja salvesti Nox A1 

jaoks klõpsama Scan (Otsimine) või salvesti Nox A1 seerianumbri manuaalselt sisestama. Veenduge, et salvesti 

A1 oleks selle etapi jaoks sisse lülitatud. Valige loendist oma salvesti ja klõpsake Next (Järgmine).  
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Kui olete saadavalolevate seadmete kogusse lisanud kasutusel olevad seadmed, saate valida seadmed, et 

lisada need online'is jälgitavasse tuppa.  

 

Toale lisatavate seadmete valimiseks klõpsake seadmel ning seejärel kuvatakse iga valitud seadme ümber paks 

sinine raam. Kui olete toale lisatavad seadmed valinud, klõpsake Add to Room (Toale lisamine) ja valitud 

seadmed lisatakse teie toale. 

 

Online'is jälgitava toa konfigureerimine on nüüd lõpetatud. Täiendavaid tube saate lisada ülalkirjeldatud viisil.  
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Uute andurite konfiguratsioon 

Kui soovite luua uued anduri konfiguratsioonid, nt kasutamiseks Nox C1 pääsupunktiga, liikuge rakenduse 

Noxturnal tööriistaribal Devices > Sensors… (Seadmed > Andurid ...). 

   

Viisardis Manage Sensors (Andurite haldamine) saate luua uue anduri ja redigeerida/kustutada olemasolevaid 

andureid. Uue patsiendi- või lisaseadme anduri loomiseks klõpsake New (Uus). Patsiendiandurid on andurid, 

mis on ühendatud salvestiga Nox A1, T3 või T3s ja patsiendiga. Lisaseadme andurid on ühendatud Nox C1 

pääsupunkti ja lisaseadmega.  

 

Saate valida, kas luua uus patsiendiandur või lisaseadme andur. Täitke vajalikud väljad ja klõpsake anduri 

konfiguratsiooni salvestamiseks OK. 

Online seadmete profiilid 

Online'is salvestamiseks ette nähtud Nox seadmete jaoks saate seadistada seadmeprofiilid. Seadmeprofiilid 

hõlmavad seadme kanali konfiguratsiooni. Noxturnal pakub laia valikut seadme vaikimisi profiile ning hõlpsalt 

saab seadistada ka uued seadmeprofiilid. Seadmeprofiilide kohandamise juhiseid vt jaotisest Seadmeprofiilid. 
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Online seadmete salvestustüübid 

Viimases etapis tuleb seadistada salvestustüübid. Siin on esitatud kõikide salvestustüüpide loend, mida saate 

kliinikus online'is salvestada. Iga salvestustüüp koondab saadavalolevad online seadmetüübid, mida on 

võimalik rühmitada. Näited: standardne PSG koos Nox C1-ga, koondab Nox C1 pääsupunkti, salvesti Nox A1, 

oksümeetri Nonin 3150 ja videokaamera. Uute salvestustüüpide seadistamise juhiseid vt jaotisest 

Salvestustüübid. 

Online'is tehtud salvestise käivitamine 

Kui olete online'is salvestamise konfiguratsiooni seadistamise ülalesitatud etapid läbinud, saate käivitada 

veebis salvestamise. Lehel Recording (Salvestamine) saate seadistatud toas käivitada online'is salvestamise. 

Salvestuse käivitamiseks tehke topeltklõps toa ikoonil või klõpsake Configure Recording (Salvestuse 

konfigureerimine). 

 

See avab viisardi Start Online Recording (Käivita online'is salvestamine). See viisard võimaldab teil teha 

järgnevaid toiminguid. 

• Valige rippmenüüst Recording Type (Salvestustüüp), mille tegemist alustatakse. 

• Seadmete valik oleneb valitud salvestustüübist. Loendis on kõik toas lkasutatavad seadmed, ent 

salvestustüüpi lisamata seadmete taust on hall. Seadmed saate salvestusse lisada, kui valite 

seadmete loendist vajaliku seadme. 

• Mõne seadme, nt Nox A1 ja Nox C1, jaoks valige Device Profile (Seadmeprofiil). 
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Kui olete valinud salvestustüübi ja õiged seadmed nende seadmeprofiilidega saate patsiendi andmete 

sisestamiseks klõpsata Next (Järgmine). Viimane etapp on salvestuse käivitamine, selleks klõpsake viisardis 

Patient Information (Patsiendi andmed) Start Recording (Salvestuse käivitamine) või Standby (Ootel).  

Salvestuse käivitamine 

Seejärel näete valitud töökeskkonna kujundust olekuaknaga, mis näitab käivitatava salvestuse olekut. Viimaks 

näete reaalajas ilmuvaid salvestatud signaale ja saate nendega tööd alustada. 

Ooterežiim 

Valik Standby Mode (Ooterežiim) avab teie valitud töökeskkonna olekuaknaga, mis näitab, et olete sisenenud 

ooterežiimi, mis annab võimaluse võtta ühendust online'is jälgitava toaga patsiendi ühendamise 

ettevalmistamiseks, hindamiseks ja assisteerimiseks ning lõpuks alustada salvestamist rakenduse Noxturnal 

või nupu Start Recording (Salvestamise käivitamine) abil. 
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Kui kasutaja on rakenduse Noxturnal online toaga ühendanud, EI salvestata veel reaalajas nähtavaid graafikuid. 

Tegemist on ainult eelvaatega, mida kinnitab eelvaate olek. Signaali hakatakse salvestama niipea, kui kasutaja 

vajutab Start Recording (Salvestuse käivitamine) rakenduses Noxturnal või tarkvaras Noxturnal. 

 

Kasutaja võib ekraani ülaosas oleval punasel salvestamisnupul klõpsates siseneda ka ooterežiimi mis tahes 

ajahetkel pärast seda, kui salvestamine on käivitatud, kui ta soovib teatud perioodiks salvestamist peatada. 

 

Salvestamisnupu klõpsamine annab valiku siseneda ooterežiimi, peatada või lõpetada salvestamine ning 

jätkata salvestamist. 

 

 

Impedantsi kontrollimine ja biokalibreerimine 

Elektroentsefalograafia (EEG) elektroodide lähemaks kontrollimiseks võib läbi viia impedantsi kontrolli. Pärast 

salvestamise alustamist klõpsake nuppu "Ohm”.  
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Ringide värvid näitavad ühenduste kvaliteeti. Roheline on hea (<5 kΩ), kollane on piisav (5 kΩ kuni 20 kΩ) ja 

punane on halb (>20 kΩ).  

Järgmine samm on biokalibreerimine. Minge skoorimisnupule ja valige Bio Calibration (Biokalibreerimine). 

 

Valitud ülesanne tõstetakse esile ja oodatav tulemus kuvatakse vahekaardi allosas. Kui sündmus on skooritud, 

ilmub sündmus signaalilehele.  
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Nox C1 konfiguratsioon 

Nox C1 pääsupunkt on varustatud 12 analoogkanaliga, mis sobivad lisaseadmetest alalisvoolusignaalide 

kogumiseks. Kanalid on kogutud 6 porti märgistustega DC IN 1 kuni 12 seadme ülaosas; igas analoogpordist 

väljub 2 kanalit. Lisaseadmeid on võimalik ühendada Nox C1 analoogsisenditesse. Voltaaživahemik võimaldab 

liidestamissignaale –5 V kuni +5 V. Nox C1 pääsupunkti kohta saate lisateavet Nox C1 kasutusjuhendist.  

Nox C1 pääsupunkti võrgukonfiguratsioon 

Nox C1 pääsupunkti tehase vaikimisi seadistused on loetletud allpool olevas tabelis. Nox C1 

võrgukonfiguratsiooni saab hallata läbi rakenduse Noxturnal. 

Nox C1 võrgukonfiguratsioon Üksikasjad 

DHCP server DHCP aadressivahemik: 192.168.101.64–192.168.101.127 

Staatiline IP-aadress 192.168.101.10 

Universaalse isehäälestumise (UPnP) 

tuvastus 

Võrguprotokoll, mis võimaldab Nox C1 võrgust leida  
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Nox C1 võrgukonfiguratsiooni haldamiseks avage konfigureeritud online'is jälgitav tuba (Devices > Online 

Rooms... (Seadmed > Online'is jälgitavad toad...)), valige toas Nox C1 ja klõpsake Edit Device (Seadme 

redigeerimine). Allolevas dialoogiaknas näete, kuidas saate Nox C1 võrgukonfiguratsiooni muuta.  

 

Nox C1 pääsupunkti püsivara uuendamine 

Kui saadaval on pääsupunkti Nox C1 uus püsivaraversioon ühendatud seadme jaoks, teavitab Noxturnal 

kasutajat sellest teate kuvamise teel, kui kasutaja käivitab online'is salvestamise. 
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Kasutaja pääseb püsivarauuendusele juurde menüüribal vahekaardile Devices (Seadmed) navigeerimise teel. 

Devices >> Online Rooms… (Seadmed > Online jälgitavad toad...)  

 

Valige Nox C1 pääsupunkt ja klõpsake Edit Device (Seadme redigeerimine). 

 

Seadme omaduste aknas valige Upgrade Firmware (Püsivara uuendamine). 
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Püsivarauuenduse edenemist näidatakse olekuribaga ja kui see on lõpetatud, kuvatakse järgnev. 

 

Nox DC kanali litsentsi aktiveerimine 

Nox C1 pääsupunkti DC kanalid on vaikimisi lukustatud. Nox C1 DC kanalite kasutamiseks peab olema Nox DC 

kanali litsents aktiveeritud. Lisateavet selle kohta saate ettevõttelt Nox Medical või selle müügiesindajatelt. 

Litsentsi saab aktiveerida klõpsates dialoogiaknas Device Properties (Seadme omadused) Set License (Litsentsi 

seadmine), mida on näidatud allpool, ja järgides lehel esitatud juhiseid. 
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Online'is salvestamise jaoks videoseadmete integreerimine  

Noxturnal toetab online'is video salvestamist. Noxturnali pakutava digitaalse video toe kasutamiseks online'is 

peate oma süsteemi konfigureerima nii, et see hõlmaks videoseadet. 

Online konfiguratsiooni saab lisada videoseadme ja salvestada seadistuse edaspidiseks kasutamiseks. 

Videoseadme süsteemiga konfigureerimiseks tuleb toimida järgmiselt. 

1. Veenduge, et arvutisse oleks salvestatud videokoodekid. 

2. Veenduge, et videoseade oleks ühendatud samasse võrku nagu Nox C1 pääsupunkt ja arvuti, kus 

töötab rakendus Noxturnal  

3. Seadistage online'is jälgitav tuba, mis sisaldab videoseadet 

4. Seadistage salvestustüüp, mis hõlmab videoseadet ja määrake videoprofiil  

5. Valige online'is jälgitav tuba ja alustage online'is salvestamist rakenduse Noxturnal lehelt Recording 

(Salvestamine) 

Videoseadmega online'is jälgitava toa seadistamine 

VIDEOKOODEKID 

Rakenduse Noxturnal videotuge juhivad videokoodekid, mis on installitud teie arvutisüsteemi. Videokoodekid 

on eriotstarbeline tarkvara, mis võimaldab digitaalvideo tihendamist ja lahti pakkimist. Noxturnal ei installi 

ühtki koodekit, kuid enamasti on arvutisüsteemis mõnda tüüpi koodekid juba installitud. Arvutisse installitud 

koodekeid on vaja videote kasutamiseks Nox uneuuringusüsteemiga. Noxturnal võimaldab juurdepääsu nende 

koodekitega toetatud funktsioonidele. Koodekid K-Lite Codec Pack saab alla laadida ettevõtte Nox Medical 

tehnilise toe lehelt:  

http://support.noxmedical.com/hc/en-us/articles/207882176  

VIDEOKAAMERA INTEGREERIMINE 

Videoseadmega online salvestuse seadistamiseks järgige alltoodud samme. 
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1. Seadistage rakenduses Noxturnal online'is jälgitav tuba, nagu selgitatakse jaotises Online'is jälgitav 

tuba (Devices > Online Rooms… (Seadmed > Online'is jälgitavad toad...) rakenduse Noxturnal 

tööriistaribal).  

2. Lisage online'is jälgitavasse tuppa videoseade klõpsates nupul Add Devices (Seadmete lisamine) ja 

valige Video Device (Videoseade) loendist Device Types (Seadmetüübid).  

       

3. Ilmub allpool näidatud seadmete atribuutide dialoog. Märkige sobiv valik olenevalt kasutatavast 

videoseadmest ja klõpsake Next (Järgmine). 
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Find... (Otsimine...) ning Noxturnal vaatab läbi teie võrgu ja leiab võrguga ühendatud videokaamerad, kui neil 

on lubatud UPnP (võrguprotokoll, mis võimaldab võrgus IP-kaamera tuvastada). Teatud IP-kaameratele 

(kaamerad Axis, D-Link, Vivotek ja Hikvision) pakub Noxturnal ühenduse vaikimisi valikuid. Rakenduses 

Noxturnal saadavaloleva ühendusstringi valimisel veenduge, et valite ühendusstringi (URL) tehtava salvestuse 

järgi, kui salvestatakse ainult videot või nii videot kui ka heli.  

Kui Noxturnal ei tuvasta toiminguga Find… (Otsimine...) kaamerat automaatselt, saate oma kaamera alati ka 

manuaalselt lisada, kui sisestate väljale File or URL (Fail või URL) vastava ühendusstringi (URL) ja kaamera IP-

aadressi. 
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Kui teil on videoseade, mida eelmainitud ühenduse vaikimisi valikud ei toeta, võite alati lisada uued 

ühendusstringid (URL), mis on edaspidi rakenduses Noxturnal kättesaadavad. Selleks liikuge Tools > Settings > 

Advanced (Tööriistad > Sätted > Täpsemalt) ja valige Default Settings (Vaikimisi sätted). Avage videoprofiilide 

kaust ja avage Exceli tabel IPCameras (IP-kaamerad). Saate olemasolevasse ühendusstringide loendisse oma 

videoseadme jaoks lisada uue ühendusstringi, mis on edaspidi rakendusega Noxturnal kasutamiseks saadaval.  

Kui olete sisestanud kaamera kasutajatunnuse ja parooli, võite klõpsata Start Preview (Eelvaate käivitamine), 

et näha, kas teie kaamera on õigesti seadistatud ja töötab rakendusega Noxturnal. Kui eelvaate ajal esineb 

viivitus, võib omakorda lisada viivitussisendi, et korrigeerida analüüsi ajal video taasesitus. Klõpsake Next 

(Järgmine), et anda kaamerale ainuomane nimi, ja seejärel klõpsake Finish (Lõpeta).  
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Nüüd on videoseade online'is jälgitavale toale lisatud.  

Videoseadme salvestustüübi seadistamine 

Noxturnal pakub videoseadet hõlmavate online'is salvestamiste jaoks salvestuse vaikimisi tüüpe. Võite valida 

ühe salvestuse vaikimisi tüüpidest ja käivitada videoseadet hõlmava online salvestamise. Võite seadistada ka 

kohandatud salvestustüübi ning määrata online'is video salvestamisel ja tihendamisel rakenduse Noxturnaliga 

kasutatava Windows Media profiili. Selleks navigeerige rakenduse Noxturnal tööriistaribal Devices > Recording 

Types… (Seadmed > Salvestustüübid...). Salvestustüüpide viisardis valige ripploendist Recording Type 

(Salvestustüüp) New (Uus) ja Online (Online). 
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Veebipõhise salvestustüübi viisardis saate lisada oma videoseadme nii nagu teised seadmedki. Ripploendist 

saate valida kasutatava videoprofiili, vt pilti allpool.  
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Rakendus Noxturnal pakub laia valikut video vaikimisi profiile, kuid saate luua ka kohandatud profiile ja 

pääsete neile juurde, et neid rakenduses Noxturnal kasutada. Lisateavet ja juhiseid leiate ettevõtte Nox 

Medical tehnilise toe lehelt (rakenduse Noxturnal Windows Media profiilid). 

Nüüd on online'is salvestamine koos videoseadmega konfigureeritud ja võite alustada online'is salvestamist 

rakenduse Noxturnal lehelt Recording (Salvestamine), kui teete topeltklõpsu toal või klõpsate Configure 

Recording (Salvestuse konfigureerimine). 
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Salvestistega töötamine rakenduses Noxturnal  

Salvestuse tulemuste leht  

Pärast salvestuse seadmest allalaadimist või olemasoleva salvestise avamist rakenduses Noxturnal, kuvatakse 

leht Recording Results (Salvestuse tulemused). See leht annab ülevaate tavapärastest analüüsi parameetritest 

ja salvestatud signaalidest. Tulemuste lehte uuendatakse automaatselt, kui olemasolevale skooritud 

tulemusele tehakse muudatusi või käivitatakse automaatne analüüs. Kui saadaval on unestaadiumid, nt 

salvestiga Nox A1 tehtud salvestuste korral, näete vastava teabega graafikuid ja andmeid. Salvestite Nox T3 

puhul näete vaid selle seadmega saadavalolevaid parameetreid. 

 

Tulemuste lehe toimingud 

Lehel Recording Results (Salvestuse tulemused) on nupud järgmiste toimingute jaoks. 

• View Report (Raporti vaatamine): see valik loob salvestise vaikimisi raporti, mis on salvestustüübile 

määratletud (lisateavet vt jaotisest Salvestustüübid). 

• Print Report (Raporti printimine): see valik prindib vaikimisi raporti ja/või salvestuse tulemuste lehe. 

• Recording Status (Salvestuse olek): see valik võimaldab määrata salvestustele oleku. Allalaaditud 

salvestuste olek on alati New (Uus). Kui salvestamine mingil põhjusel ebaõnnestus, saab olekuks 

märkida Invalid (Kehtetu). Kui salvestus on analüüsitud, saab olekuks märkida Scored (Hinnatud). Kui 

salvestis ja hinnang on ülevaadatud, saab olekuks märkida Reviewed (Ülevaadatud). Kui salvestist on 

tõlgendatud, saab olekuks märkida Interpreted (Tõlgendatud). Kui salvestus on analüüsitud ja 

aktsepteeritud, saab olekuks märkida Done (Valmis). 

Patsiendi andmed 

Teabepaneelil Information (Teave) näidatakse andmeid salvestatud patsiendi kohta. Salvestamisomadusi ja 
patsiendi andmeid saab redigeerida klõpsates patsiendiikoonil või vajutades kiirklahve Ctrl+I. 
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Une parameetrid 

Teabepaneelil Sleep Parameters (Une parameetrid) näidatakse erinevate unestaadiumide sektordiagrammi, 
kui unestaadiumid on hinnatud. 

 

 

• Total Sleep Time (Kogu une aeg) on aeg, mil patsient magas (hüpnogrammi alusel). 

• Kui Total Sleep Time (Kogu une aeg) ei ole kättesaadav, siis kasutatakse parameetrit Est. Total Sleep 

Time (Eeldatav kogu une aeg) (sama, mis AASM-i termin jälgimise aeg (Monitoring Time)). See on aeg, 

mille vältel patsient lamab salvestamise ajal. 

• Sleep Efficiency (Une tõhusus) varieerub 0–100%, kus 0% tähendab, et patsient oli kogu öö ärkvel ja 

100% tähendab, et ta magas kogu öö. Kui une hindamine ei ole kättesaadav, kasutab tarkvara selle 

parameetri hindamiseks liigutusi. 

Respiratoorsed indeksid 

Paneelil Respiratory Indices (Respiratoorsed indeksid) näidatakse peamisi analüüsiparameetreid ja nende 

seost raskusastmega. AHI (apnoe-hüpopnoe indeks) on apnoede ja hüpopnoede arv ühe unetunni kohta ja 

hapniku desaturatsiooni indeks (ODI) on hinnatud hapnikuga küllastuse langused ühe unetunni kohta (vaikimisi 

automaatne analüüs hindab kõiki saturatsiooni langusi, mis on vähemalt 3% või suuremad, ent see on kasutaja 

poolt kohandatav). Raskusaste võib olla Normal (Normaalne) → Mild (Kerge) → Moderate (Keskmine) → 

Severe (Raske) ja on kooskõlas AASM-i määratletud tasemetega. Kui salvestatud on enam kui üks öö, siis 

näitavad need parameetrid kõigi ööde keskmist väärtust. Lisateabe saamiseks vt jaotist Analüüsiprotokollid. 
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Üldine signaali kvaliteet ja sama uuritava andmed 

Üldine signaali kvaliteet määratakse järgmiste signaalide kvaliteedi jälgimise teel: oksümeetri, õhuvoolu, kõhu 
või rindkere respiratoorse pingutuse signaalid. Nende signaalide madalaim signaali kvaliteet kuvatakse üldise 
signaali kvaliteedina salvestuste tulemuste lehel ja see jääb vahemikku 0–100%.  

Tulemus Single Body Source (Sama uuritava andmed) näitab, kas oksümeetri ja RIP-vöö signaalid pärinevad 

samalt uuritavalt. Lisateavet selle tulemuse kohta saab jaotisest Single Body Source (Sama uuritava andmed). 

 

Signaali ülevaade ja parameetrid 

Teabepaneel Signal Overview (Signaali ülevaade) on ülevalt alla keritav ülevaade, kus salvestustulemusi on 

lihtne üle vaadata ja redigeerida. Ülevaate paneel on jagatud nõnda, et analüüsiparameetrid asuvad paremal ja 

signaali ülevaade asub vasakul. 

 

Analüüsiparameetrid näitavad kõige tavapärasemate analüüsiparameetrite kokkuvõtet ühe öö kohta. Kui 

salvestatud on rohkem kui üks öö, siis on iga öö esitatud eri paneelil. Võimalik on valida vaadeldav periood ka 

rakenduse alumises paremas nurgas oleva perioodimenüü abil. Igal parameetril on värvikood, mis põhineb 

selle raskusastmel ja varieerub rohelisest punaseni (Normal (Normaalne) → Mild (Kerge) → Moderate 

(Keskmine) → Severe (Raske)). 

• Arousal Index (Virgumise indeks) on virgumiste arv ühe tunni une kohta. 
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• Sleep Latency (Une latentsus) on aeg minutites, mis kulub tulede kustutamisest (analüüsi alguse aeg) 

kuni esimese hinnatud uneni. 

• REM Latency (REM-i latentsus) on aeg minutites, mis kulub une esimeste märkide esinemisest kuni 

esimese REM-i ilmnemiseni. 

• Hingamine on esitatud indeksitega. Indeksid on analüüsiparameetrite standardse esitamise meetod. 

o Apnoe-hüpopnoe indeks (AHI) 

o Apnoe indeks (AI) 

o Hüpopnoe indeks (HI) 

o Hapniku desaturatsiooni indeks (ODI) näitab hapniku desaturatsiooni sündmusi ühe tunni 

kohta kogu une ajal või teise võimalusena eeldatava kogu une aja kohta. 

o Norskamise protsent on norskamisepisoodidega veedetud une kaal (märgitakse kui Snore 

Trains (Norskamisepisoodid)) 

o Keskmine dB on keskmised dB-de tasemed norskamise ajal. 

• Signal Quality (Signaali kvaliteet) määratakse järgmiste signaalide kvaliteedi jälgimise teel: SpO2, 

õhuvoolu, kõhu või rindkere respiratoorse pingutuse signaalid. Nende signaalide kvaliteet on ja 

esitatakse vahemikus 0–100%. 

Signaalid ja sündmused 

Signaali ülevaate paneelil olev signaalide ja sündmuste diagramm annab ülevaate kogu öö kohta. 

• Ülevaate signaalide hulka võivad kuuluda: 

o ekraanil kuvatava kanali spektrogramm (klõpsake spektrogrammil paremat hiireklahvi, et 

kanalit muuta);  

o une etapid / hüpnogramm näitab kogu öö une etappe; 

o virgumised näitab virgumisi kogu öö jooksul;  

o liigutused; 

o Asend 

o apnoed/RIP-faas (kõhu ja rindkere vaheliste respiratoorse pingutuse signaalide faas); 

o hapnikuga küllastus (SpO2); 

o pulss; 

o helitugevus (norskamise dB);  

o jalgade liigutused (valikuline). 

• Ülevaates näidatavate sündmuste hulka kuuluvad apnoed ja hüpopnoed, hapnikuga küllastatuse 

langused, norskamisepisoodid ja artefaktid. 
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Analüüsi ajavahemike muutmine 

Kui salvestamine algab enne kui kõik andurid on ühendatud või kui patsient eemaldab andurid enne 

salvestamise lõppu, on võimalik reguleerida analüüsitavat intervalli analüüsi alguse  ja analüüsi lõpu 

markerite  liigutamise teel sobivasse kohta salvestises. Kui need muudatused tehakse, uuendatakse kõiki 

analüüsiparameetreid vastavalt. 

 

Salvestises navigeerimiseks kasutage sünkroonimismarkerit . Kõik signaali lehed, nagu PSG, Respiratory 

(Respiratoorne) ja Pulse Oximeter (Pulssoksümeeter) sünkroonitakse vastavalt. Kui huvipakkuv sündmus on 

ülevaates, lohistage sünkroonimismarker üle selle piirkonna ja leidke asjaomane signaalileht, et näha 

algsignaale.  

Sündmuste perioode saab lisada otse paneelilt Signal Overview (Signaali ülevaade). Sündmuse perioodi 

lisamiseks viige hiire kursor paneelile Periods (Perioodid) ja klõpsake hiire nuppu. Sündmuste perioodi menüü 

on kättesaadav, nagu all näidatud.  

 

Kehtetud andmed on võimalik eemaldada paneelil Signaali ülevaade. Kehtetute andmete eemaldamiseks 

salvestusest viige hiire kursor signaalidele, klõpsake vasakut hiire nuppu ja valige piirkond vasakule/paremale 
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lohistamise teel. Vabastage hiire nupp ja all näidatud menüü muutub kättesaadavaks. Kehtetute andmetega 

seotud sündmused eemaldatakse raporti arvutustest. 

 

 

Ühikute seadistamine 

Pikkust ja kaalu näitavate mõõtühikute muutmiseks liikuge rakenduse Noxturnal tööriistaribal Tools > 
Settings… (Tööriistad > Sätted...). Otsige lehelt General (Üldised) omadused ripploend System Units (Süsteemi 
ühikud) ja valige redigeerimiseks sobiv väli. 
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Signaalide vaatamine 

Nupp Workspace Menu (Töökeskkonna menüü) 

Nupp Workspace Menu (Töökeskkonna menüü) võimaldab rakendada erinevaid töökeskkonna kujundusi ja 

signaalilehti, et hallata salvestiste nägemise viisi. Töökeskkonna kujunduse hulka kuulub signaalilehtede ja 

signaalilehe omaduste valik. Noxturnal pakub laia valikut töökeskkonna vaikimisi kujundusi (hingamise ja PSG 

kujundused) ja signaalilehti. Saate seadistada ka kohandatud töökeskkonna kujunduse ja signaalilehed. Saate 

kõik töökeskkonna kujunduse muudatused salvestada edaspidi kasutamiseks. See tähendab, et saate signaali 

graafikasätteid muuta ja seadistada oma töökeskkonda nii, nagu soovite. 

 

Töökeskkonna menüü nupuga saate lisada lehe (Add Sheet (Lehe lisamine)), luua vaikimisi kujunduse põhjal 

uue töökeskkonna kujunduse (New Workspace Layout (Uus töökeskkonna kujundus)) või taastada kujunduse 

pärast muudatuste tegemist (Revert Layout (Kujunduse taastamine)). 

 

Kohandatud signaalilehe salvestamiseks tehke paremklõps signaalilehe vahekaardil ja valige Save Sheet Layout 

As... (Lehekujunduse salvestamine nimega...). Kui olete kohandatud signaalilehe salvestanud, saate 

lisamuudatuste tegemise korral kasutada alati funktsiooni Update Saved Layout (Salvestatud kujunduse 

uuendamine). Lisateavet signaalilehtede kohta saate jaotisest Signal Sheets (Signaalilehed). 
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Signaalilehed 

Signaalileht näitab töökeskkonna vahelehel üht või enamat signaali. Rakendusel Noxturnal on eelmääratletud 

signaalilehed, nagu leht Respiratory (Hingamine), PSG (PSG) ja Pulse Oximeter (Pulssoksümeeter). 

Signaalilehel signaalide lisamiseks või eemaldamiseks viige hiir töökeskkonnas paremal asuvale aknale Signals 

and Data (Signaalid ja andmed). Kui kursor on selle vahekaardi kohal, libiseb välja tööaken Signals and Data 

(Signaalid ja andmed). Selles tööaknas on loend kõigi saadavalolevate signaalidega. Signaali kõrval olev 

märkeruut määrab, kas signaal kuvatakse lehel või mitte. Lisage/eemaldage märgistus, et signaal lehele lisada 

või sealt eemaldada. Vaadake allpool esitatud vahelehte Signals & Data (Signaalid ja andmed). 
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Signaalidega töötamine 

 

Navigeerimisriba võimaldab liikuda kiiresti salvestise mis tahes ajale. Sinine joon näitab, millises 

salvestuse osas kasutaja on. Klõpsake ribal mistahes kohal, et liikuda selle aja juurde. 

Ajatelg kuvab aknas salvestuse kellaaja ja ajavahemikku. Tehke ajateljel paremklõps, et muuta aknas 

ajavahemikku. Ajatelge saab hiire abil venitada / kokku suruda, et muuta aknas ajavahemikku. 

Ajateljel asuvat sünkroonimismarkerit kasutatakse muude signaalilehtede ja vaadetega sünkroonimiseks. 

Navigeerimisribast paremal asuv kell näitab markeri asendi kellaaega. Sünkroonimismarkerit saab ajas 

lohistada ja liigutada. 

Signaali väärtuse teljel kuvatakse vastava graafiliselt kujutatud signaali nimi ja väärtustelje skaala. Telge 

on võimalik hiirega venitada / kokku suruda. Väärtuse telje omaduste muutmiseks tehke teljel 

topeltklõps, misjärel ilmub dialoogiaken, kus on võimalik omadusi muuta. 

Signaali graafik paanil. Signaale saab mitmel viisil muuta. Muutke signaalipaani suurust või liigutage 

signaalipaani hiire abil. Signaali omaduste muutmiseks tehke signaalil topeltklõps, misjärel ilmub 

dialoogiaken, kus on võimalik signaali omadusi muuta. Üksiku signaali kõikidele toimingutele 

ligipääsemiseks tehke paremklõps signaalil, misjärel ilmub järgnev menüü. 
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Navigeerimine klaviatuuriga 

Signaalilehe navigeerimiseks ja käsitsemiseks vajutage järgnevaid kiirklahve. 
 
Navigeerimine 

• Nool paremale = vaikimisi poole lehekülje edasikerimine, kasutaja poolt konfigureeritav 

• Nool vasakule = vaikimisi poole lehekülje tagasikerimine, kasutaja poolt konfigureeritav 

• Ctrl + nool paremale = vaikimisi terve lehekülje edasikerimine, kasutaja poolt konfigureeritav 

• Ctrl + nool vasakule = vaikimisi terve lehekülje tagasikerimine, kasutaja poolt konfigureeritav 

• Klahv Page Down (lehekülg alla) = lehe edasikerimine 

• Klahv Page Up (lehekülg üles) = lehe tagasikerimine 

• Klahv Home = salvestuse algus 

• Klahv End = salvestuse lõpp 

• Shift + parem nool = suurendab aknas ajavahemikku 

• Shift + vasak nool = vähendab aknas ajavahemikku 

• Shift + Ctrl + vasak nool = liigub eelmise andmeseansi juurde 

• Shift + Ctrl + parem nool = liigub järgmise andmeseansi juurde 

• Klahv – = valiku väiksemaks muutmine 

• Klahv + = valiku suuremaks muutmine 

• Hiire kerimisnupp = kerib edasi/tagasi 

• Hiire kerimisnupp + klahv Ctrl = kerib üles ja alla 

Aktiivne signaal 

• Shift + nool üles = suurendab signaali skaalat 

• Shift + nool alla = vähendab signaali skaalat 

• Ctrl + nool üles = nihutab signaali üles 

• Ctrl + nool alla = nihutab signaali alla 

• Shift + Return (tagasi) = näitab aktiivset signaali uuel lehel 

• Shift + Delete (kustuta) = eemaldab aktiivse signaali lehelt 

• Nool üles = valib signaali ülal 

• Nool alla = valib signaali all 

• Ctrl + F = leiab sündmused 

• F9 = skaleerib signaali automaatselt 

Signaalileht 

• Tühik = esitab/peatab salvestise taasesituse 

• Ctrl + W = skaleerib signaalid automaatselt 

• Ctrl + A = järjestab signaalid 

Sündmused 

• Tab = järgmine sündmus, kui otsite, siis järgmine otsingutulemus 

• Shift + Tab = eelmine sündmus, kui otsite, siis eelmine otsingutulemus 

• Delete = kustutab valitud sündmused või kustutab valiku kattuvad sündmused 

• Return = tühistab kõikide sündmuste valikud 
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• Esc = eemaldab kõik valikud 

Sündmustega töötamine 

Sündmusi kasutatakse signaali kanalil erinevate kõrvalekallete tuvastamiseks. Sündmusel on alguse ja lõpu aeg 

ning klassifitseerimiseks kasutatav tüüp. Sündmusi saab signaalile kõrvalekallete tähistamiseks lisada 

manuaalselt või hinnata automaatse analüüsi puhul huvipakkuvaid signaali alasid. Sündmusi on võimalik muuta 

või eemaldada. 

Sündmuse hindamine 

Sündmuse hindamiseks minge signaale sisaldavale lehele; leidke huvipakkuva signaali ala. 

 Tõstke vasaku hiirenupuga ala esile, et hinnata sellel olevat sündmust. 

 Vajutage selle sündmuse kiirklahvi. Sündmuse tüübile saab kiirklahvi määrata, kui liigute Setting -> Event 

Types & Groups -> Edit -> Behavior (Sätted -> Sündmuste tüübid ja rühmad -> Redigeerimine -> Toiming). 

 

Sündmuse hindamise teine võimalus on tõsta vasaku hiirenupuga ala esile, nagu eelnevalt kirjeldatud, ent 

seejärel teha sellel alal paremklõps ja valida loendist sündmus. 

Ühe klõpsuga hindamine 

Noxturnal pakub võimalust Single Click Scoring (Ühe klõpsuga hindamine). Ühe klõpsuga hindamise 

aktiveerimiseks klõpsake rakenduse Noxturnal tööriistaribal olevat ikooni I.  

 

Hinnake valitud signaalilehel olevat huvipakkuva signaali sündmust manuaalselt. Juhiseid sündmuse 

manuaalseks hindamiseks vaadake eestpoolt jaotisest Sündmuse hindamine. Kui olete esimese sündmuse 



rakenduse Noxturnal kasutusjuhend 

   

~ 60 ~ 

hinnanud, lubab ühe klõpsuga hindamise funktsioon sama sündmuse tüüpi ühe hiireklõpsuga edasi hinnata sel 

ajal, kui te salvestist sirvite. 

Sündmuse kustutamine 

Olemasolevate sündmuste kustutamiseks on mitu võimalust. 

• Valige vasakklõpsuga sündmus ja seejärel vajutage klahvi Delete (Kustutamine). 

• Tehke sündmusel paremklõps ja valige Remove Event (Sündmuse eemaldamine). 

• Valige hiirega ala, mis lõikub kustutatavate sündmustega ja vajutage klahvi Delete (Kustutamine). 

Sündmuse liigutamine 

Sündmuse teise kohta liigutamiseks valige sündmus vasakut hiirenuppu all hoides ja seejärel lohistage 

sündmus soovitud asukohta. Sündmusi saab lohistada signaalide vahel ja ka teise ajavahemikku. 

Sündmuse suuruse muutmine 

Sündmuse suuruse muutmiseks viige hiire kursor sündmuse vasaku või parema piiri kohale. Kursor peaks 

muutuma ikooniks, millel on paremale ja vasakule suunatud nool. Kui ikoon on nooleks muutunud, tehke 

vasakklõps ja lohistage sündmus soovitud ajavahemikku. 

Sündmuste vahel navigeerimine 

Hinnatud sündmuste vahel navigeerimiseks salvestises on mitu võimalust. 

• Liikuge signaalil hinnatud sündmuste vahel, klõpsake signaalile ja seejärel vajutage klahvi Tab, millega 

liigutakse ajas järgmise sündmuseni. Eelmise sündmuse juurde liikumiseks vajutage nuppe Shift + 

Tab. 

• Töökeskkonna paremal ülanurgas on otsinguväli, mis võimaldab otsida mistahes hinnatud sündmusi. 

Otsinguväljale klõpsamise järel kuvatakse kõikide hinnatud sündmuse tüüpidega ripploend. Teatud 

tüüpi sündmuste otsimiseks klõpsake loendis sündmuse tüübil. See näitab järgmist seda tüüpi 

sündmust. Klõpsake ripploendi navigeerimisnuppudel, et sündmuste vahel navigeerida. 

• Valige rakenduse Noxturnal tööriistaribal View > Event Overview (Vaade > Sündmuse ülevaade), et 

tuua esile ülevaateaken, mis kujutab graafikul kõiki hinnatud salvestise sündmusi. Kindla sündmuse 

juurde navigeerimiseks klõpsake sellel ülevaategraafikul. 
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Artefaktidega kokku langevad sündmused  

Artefaktidega kokku langevad sündmused loetakse. Kuid kehtetute andmetega kokku langevad sündmuseid ei 

loeta ja need joonistatakse tuhmilt. Vaadake allolevaid jooniseid:  

 

 

kaks desaturatsiooni, millest üks kattub artefaktiga, on joonistatud ühte moodi 

 

kaks desaturatsiooni, üks on joonistatud tuhmilt, kuna seda ei arvestata 
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Analüüsiprotokoll  

Analüüsiprotokoll on detektorite komplekt, mida kasutatakse erinevate salvestatud signaalides esinevate 
sündmuste tuvastamiseks ja tähistamiseks. Saadavalolevad analüüsiprotokollid, sh vaikimisi protokollid, on 
esitatud menüüs Analysis (Analüüs). Salvestises analüüsiprotokolli käivitamiseks valige menüüst Analysis 
(Analüüs) sobiv analüüs ja klõpsake sellel. 

Noxturnal pakub mitmeid vaikimisi analüüsiprotokolle ja võimaldab luua ka uue analüüsiprotokolli, mis 

kasutab kohandatud sätteid ja/või detektoreid. Kohandatud analüüsiprotokolli seadistamiseks liikuge 

rakenduse Noxturnal tööriistaribal Analysis > Manage Protocols (Analüüs > Protokolli haldamine). 

Olemasoleva protokolliga saate teha toiminguid Edit (Redigeerimine) ja Rename (Nime muutmine) või 

vajutada New based on (Uus... põhjal), et luua uus protokoll olemasoleva põhjal.  

      

Näiteks loome uue analüüsiprotokolli. Valige dialoogiaknas Manage Analysis dialog (Analüüsi haldamine) New 

(Uus). Avaneb uus leht Analysis Protocol (Analüüsiprotokoll), kust leiate uue protokolli. Protokoll on 

detektorite kogum ja detektori ülesanne on leida signaalist huvipakkuvad alad ning hinnata alasid 

sündmustega.   
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Detektori lisamiseks protokolli valige loendist Detectors (Detektorid) detektor ja valige Add Detector >> 

(Detektori lisamine) General Properties (Üldomadused) ja Input Signal (Sisendsignaal).   

Kui analüüsiprotokoll on seadistatud, klõpsake Save and Close (Salvesta ja sulge) ning protokoll lisatakse 

saadaval olevate analüüside loendisse.  

Hinnangutega töötamine 

Hinnang on sündmuste kogum, mida on salvestise signaalidel hinnatud. Hinnangutega töötamise toimingud 

asuvad rakenduse Noxturnal tööriistaribal nupul Scoring (Hindamine). Hinnangutega töötamisel tehtavad 

toiminguid on loetletud allpool esitatud jaotistes.  

  

Kui olete salvestusele konfigureerinud salvestustüübi ja lisanud analüüsiprotokolli, siis kasutab Noxturnal Nox 

salvestusseadmest alla laadimise korral salvestuse analüüsimiseks automaatselt analüüsi vaikimisi protokolli. 

Online'is tehtavate uuringute jaoks peate salvestuse lõppemise korral selle sulgema ja kui avate selle 

salvestiste teegist uuesti, analüüsib andmeid määratletud vaikimisianalüüs. Andmete automaatne 

analüüsimine loob uue hinnangu nimega Untitled Scoring (Nimetu hindamine), vt ekraanikuva ülal. Nupu alt 

Scoring (Hindamine) näete alati valikut Selected Scoring (Valitud hindamine), mida kasutatakse raportite ja 

salvestuse ülevaate funktsiooniks. Saate lihtsalt luua uue hindamise nupu Scoring (Hindamine) funktsioonide 

abil, nt kui muudate automaatset hindamist, saate selle hõlpsalt sobiva nimega uue hindamisena salvestada. 
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Nupu Scoring (Hindamine) alt saate valikutega Add Event Period (Sündmuse ajavahemiku lisamine) või Add 

Note (Märkuse lisamine) lisada salvestusele uue sündmuse ajavahemiku või tehnilise märkuse. 

Uus hindamine 

Kui kasutatakse EEG-d salvestavaid seadmeid, saab kasutada rakenduse Noxturnal unestaadiumi määramise 
funktsioone. Noxturnal pakub automaatset unestaadiumi määramist süsteemis, et abistada manuaalse 
hinnangu andjat.  Võimalik on unestaadiume määrata ka manuaalselt ilma automaatset unestaadiumi 
määramist kasutamata. 
Unestaadiumi saate manuaalselt määrata, kui klõpsate nupul Scoring (Hindamine), et valida New Scoring (Uus 
hindamine).  
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Seejärel valige unestaadiumi määramise käivitamiseks toiming Start Sleep Staging (Unestaadiumi määramise 

käivitamine) nupuga Scoring (Hindamine) avatavast menüüst. Unestaadiumi määramise vaikimisi 

kiirklahvidena kasutatakse klaviatuuri numbriklahve. Hindamise kiirklahve saate muuta allkirjeldatud viisil. 

Hindamise valimine 

Ühe salvestusega saab siduda mitut hindamist. Kõik saadavalolevad hindamised on esitatud hindamispaneelil. 

Valige aktiivne hindamine sellel klõpsates. 

Hindamise salvestamine 

Aktiivse hindamise saate salvestada valikul Save Scoring (Hindamise salvestamine) klõpsates. Kasutajal 

palutakse sisestada salvestatud hindamise nimi. Salvestatud hindamine lisatakse hindamiste loendisse. 

Hindamise kustutamine 

Kui hindamine on aktiivne, siis see toiming kustutab selle. Kui aktiivsel hindamisel on lokaalsed muudatused, 

küsitakse kasutajalt, kas ta soovib lokaalsed muudatused salvestada. 

          Valitud hindamise kustutamine 

Salvestatud hindamise saab kustutada selle hindamiste loendist valimise ja valikul Delete Selected Scoring 

(Valitud hindamise kustutamine) klõpsamise teel. Avaneb dialoogiaken, mis küsib, kas hindamise tohib 

kustutada. 

Hindamise kiirklahvid 

Kiirklahvi kasutatakse sündmuste kiireks hindamiseks. Sündmuse tüübile saab kiirklahvi määrata, kui liigute 

Setting -> Event Types & Groups -> Edit -> Behavior (Sätted -> Sündmuste tüübid ja rühmad -> Redigeerimine 

-> Toiming). 

Üldjuhul peaks sündmuse kiirklahv olema üks klaviatuuri märk, ent toetatud on ka klahvide Ctrl, Shift ja Alt 

kombinatsioon tähemärgiga. 

Rakenduse Noxturnal raportid  

 

 Märkus. Raporti tulemused fikseeritakse ja neid ei uuendata, kui salvestuse 

analüüs muutub. 

 Märkus. Kui analüüsile tehakse muudatused, saab luua teise raporti või 

olemasolevat raportit uuendada. 

Rakenduses Noxturnal on valik vaikimisiraporteid, mis on kergesti ligipääsetavad rakenduse Noxturnal 

tööriistaribal menüül Reports (Raportid) klõpsates.  
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Raportite loomine 

Raporti saab luua lehel Recording Results (Salvestamise tulemused) klõpsates nuppu View Report (Raporti 

vaatamine) või rakenduse Noxturnal tööriistaribal menüüst Reports (Raportid) raporti valimise teel. 

Kui raportisüsteemis on raport loodud, saate raportit hõlpsalt muuta nupu Edit (Redigeerimine) abil, mis on 

tööriistaribal nähtav raportite vaatamise ajal. 

 

Nupp Edit (Redigeerimine) käivitab funktsiooni Edit Mode (Redigeerimisrežiim), mis võimaldab redigeerida 

raportit Microsoft Word®-i kasutamisega samal viisil. Kõik tehtud muudatused on kohe nähtavad. Uuringu 

tõlgendamise ajal saab lisada ka uusi indekseid ja isegi eelmääratletud raporti osi. Redigeerimisrežiimi 

lõpetamiseks vajutage uuesti nuppu Edit (Redigeerimine). Redigeerimisrežiimis tehtud muudatusi ei salvestata 

raporti osana. 

Raportite kohandamine 

Noxturnal pakub võimsat raportite kohandamise funktsionaalust, millel on Microsoft Word®-iga sarnased 

redigeerimisvõimalused. Raporteid saab rakenduses Noxturnal lihtsalt kohandada. Kohandatud raportimudeli 

loomiseks järgige allesitatud etappe. 

1. Rakenduse Noxturnal tööriistaribalt valige Reports -> Manage Reports… (Raportid > Raportite 

haldamine...) 

2. Raportite haldamise dialoogiaknast valige olenevalt eelistustest üks valikutest Edit (Redigeerimine), 

New (Uus) või New Based On (Uus... põhjal). 

 
3. Näiteks loome uue kohandatud raporti, mis põhineb vaikimisiraportil PSG Report. Valige 

saadavalolevate raportite loendist PSG Report ja vajutage New Based On (Uus... põhjal). 

4. Näete järgnevat dialoogiakent, kus saate anda uuele raportimallile nime, seejärel valige Create 

(Loomine). 
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5. Avaneb uus valitud vaikimisi raportiga leht ja selles aknas saate seda redigeerida. Ekraani paremal 

pool on kogum Fields (Väljad) ja Report Parts (Raporti osad), mida saate oma raporti jaoks kasutada. 

Lisateavet raporti osade ja väljade kohta vt allpool asuvast jaotisest Raporti osad ja raporti väljad.  
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Märkus. Raportimudelil võite hiirt väljade (–) kohal hoida, et näha parameetri andmeid. Vaadake allolevat 

joonist. 

 

REPORTI OSAD JA RAPORTI VÄLJAD 

Iga raporti osa esindab raporti jaotist, nt oksümeetri saturatsioon, PLM-i andmed jne. Raporti osi ja välju saab 

luua rakenduses Noxturnal ning te saate vaikimisi raportite osad salvestada, et need oleksid raporti algusest 

peale loomise puhul saadaval. 

RAPORTILE UUTE OSADE LOOMINE 

Saate luua uued raporti osad ja need edaspidiseks kasutamiseks salvestada. Selleks valige raportimudelil sobiv 

raporti osa (või muu kohandatult loodud tekst/tabel), lohistage ja tõstke see loendisse Report Parts (Raporti 
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osad). Andke raporti osale nimi ja valige kategooria. Loodud uus raporti osa lisatakse loendisse Report Parts 

(Raporti osad). 
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RAPORTILE UUTE VÄLJADE LOOMINE 

Saate luua uued raportite väljad ja need edaspidiseks kasutamiseks salvestada. Selleks järgige allesitatud 

etappe. 

1. Näiteks valime kohandatud välja aluseks rakenduses Noxturnal saadavaloleva vaikimisivälja Desat 

Drop ≥ 4% Count (Desaturatsiooni ≥ 4% langus). Valige Desat Drop ≥ 4% Count (Desaturatsiooni ≥ 4% 

langus) ja klõpsake New Based On (Uus... põhjal). 

2. Andke raporti välja redigeerimise dialoogiaknas väljale nimi ja redigeerige uusi välja omadusi, nagu 

vaja. 
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Näiteks muudame desaturatsiooni languse ≥ 3 peale ja anname uuele väljale kirjeldava nime Desat Drop ≥ 3% 

Count (Desaturatsiooni ≥ 3% langus). Kui on vaja muuta tingimusi, klõpsake Conditions (Tingimused), et näha 

kõiki saadavalolevaid tingimusi.
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RAPORTITELE OSADE JA VÄLJADE LISAMINE 

Raportile osade ja väljade lisamiseks viige kursor raportil soovitud asukohta ja tehke topeltklõps soovitud 

raporti osal paremal esitatud loendis. Raportile osa ja välja lisamise teine võimalus on lohistada ning tõsta 

soovitud raporti osa/väli oma raportisse. 

RAPORTI PÄIS JA JALUS 

Raporti päise ja jaluse kohandamiseks järgige allesitatud etappe. 

1. Valige rakenduse Noxturnal tööriistaribal Tools -> Settings -> User & Company (Tööriistad > 

Sätted > Kasutaja ja ettevõte) ja näete allesitatud viisardit, kuhu saate sisestada kasutaja ja 

ettevõtte andmed.  

  

Täitke ülalesitatud väljad vastavate andmetega. Saate lisada sisestatud andmed raportisse 

vastavate raporti väljade abil.  

 

2. Andmete sisestamiseks raporti päisesse või jalusesse viige kursor raporti ülaosa kohale, tehke 

paremklõps ja valige Edit Header/Footer (Päise/jaluse redigeerimine). 



rakenduse Noxturnal kasutusjuhend 

   

~ 73 ~ 

      

 

3. Sisestage päisesse vastavad loendis saadavalolevad väljad. 

4. Logo lisamiseks raporti päisesse vajutage Format -> Insert Image… (Vorming > Pildi 

sisestamine...), nagu näidatud allpool. 

      
 

5. Raportile leheküljenumbrite lisamiseks liikuge raporti alaserva, tehke paremklõps ja valige Edit 

Footer (Jaluse redigeerimine). Tehke paremklõps jaluse piirkonnas ja valige Insert > Page 

Number (Sisestamine > Leheküljenumber). 

Kui olete raportimudeli seadistamise lõpetanud, valige Save (Salvestamine). Teie raport lisatakse loendisse 

Report (Raport), mis on leitav rakenduse Noxturnal tööriistaribalt. 

Raportite eksportimine 

Raportite eksportimiseks klõpsake raporti tööriistaribal Export (Eksportimine). 

 

See avab uue dialoogiakna, et määratleda faili vorming ja nimi. Kui olete lõpetanud, klõpsake nupul Save 

(Salvestamine) ning raport salvestatakse kettale määratud failivormingus. 
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Raportite printimine 

Kui raport on loodud, võib kasutaja selle printida. Raporti printimiseks vajutage raporti tööriistaribal Print 

(Printimine). 

 

Avaneb dialoogiaken, kus on võimalik muuta printimise seadistusi. Printimiseks klõpsake nupul Print 

(Printimine). 

Salvestiste teek 

Salvestiste teek kuvab ja haldab kõiki salvestisi, mis on alla laaditud Nox salvestusseadmetest ja online'is 

jälgitavatest uuringutest. Kui salvestised avatakse või laaditakse alla rakenduses Noxturnal, lisatakse need 

automaatselt salvestiste teeki. On võimalik hankida litsents rakenduses Noxturnal EDF-failide, EDF+-failide, 

Embla-failide ja Somnostar-failide avamiseks ning vastavad salvestused lisatakse automaatselt salvestuste 

teeki.  

Salvestuse avamiseks valige see salvestiste teegi loendist ja tehke sellel topeltklõps. 

Salvestiste arhiveerimine 

Salvestiste teegis olevaid salvestisi saab arhiveerida erinevasse asukohta või püsimällu. Salvestise 
arhiveerimiseks valige teegist üks või enam salvestist ja klõpsake nupul Archive Recording… (Arhiveerige 
salvestis) salvestise andmete paneelil. Kuvatakse dialoogiaken, mis juhendab kasutajat arhiveerimise ajal. 
 

Sama uuritava andmed 

Sama uuritava andmete algoritm on rakenduse Noxturnal patendi ootel algoritm, mis tuvastab, kas 

salvestusseadet kandis sama uuritav ja milliseid andureid salvestamise ajal kasutati. 

Algoritm esitab ühe kolmest tulemusest. Tulemused ja nende tähendused on esitatud allpool. 

• Not analyzed: (Ei analüüsitud) algoritmi ei ole salvestise jaoks kasutatud. 

• Approved: (Kinnitatud) salvestise puhul on kinnitatud sama uuritava andmed. 

• Inconclusive: (Järeldusi ei saa teha) salvestise puhul ei saa kinnitada sama uuritava andmeid. 

Tulemuseni Inconclusive (Järeldusi ei saa teha) võivad viia mitmed põhjused, sh järgmised: 

• salvestis ei sisalda vajalikke signaale (oksümeetrilt saadavat pulsi lainevormi ja vähemalt üht RIP-

signaali); 

• vajalikes signaalides on müra või need sisaldavad suuri artefakte; 

• andurid ei olnud uuritava külge kinnitatud; 

• andurid kinnitati patsiendile valesti või need liikusid une ajal kohalt; 

• oksümeetrit ja RIP-rihmu kandsid erinevad uuritavad; 

• salvestis on liiga lühike (vajalik on salvestada vähemalt 15 minutit järjest pulsi lainevormi ja RIP-

signaale); 
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• südame artefakt (seda põhjustab vere väljumine südamest arteritesse ja sellest tulenev rindkere 

liigumine) RIP-signaalides on liiga väike.k 

Sama uuritava andmete algoritmi saab kasutada tööriistana (Tools -> Single Body Source (Tööriistad -> Sama 

uuritava andmed)) või analüüsi tuvastina, mille saab lisada kohandatud analüüsiprotokolli. Tööriist käivitatakse 

automaatselt, kui salvestised on salvestusseadmest alla laaditud. 

Sama uuritava andmete tulemus kuvatakse iga öö jaoks lehel Recording Results (Salvestuse tulemused) 

jaotises Signal Overview (Signaali ülevaade) ja on saadaval ka raportiväljana lisamiseks kohandatud 

raportitesse. Tulemus esitatakse ühega järgmistest sümbolitest. 

 

Not analyzed (Ei analüüsitud) 

 

Hall ring 

Approved (Kinnitatud) 

 

Valge linnuke rohelisel ringil 

Inconclusive (Järeldusi ei saa 

teha) 

 

Valge küsimärk kollasel ringil 

Alla laaditud salvestiste sama uuritava andmete algoritmi automaatarvutust ning sama uuritava andmete 

tulemuste kuva saab sisse ja välja lülitada, kui valite Tools -> Settings… -> Advanced -> Single Body Source 

(Tööriistad -> Seaded... -> Täpsemalt -> Sama uuritava andmed).  
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Ühilduvad seadmed 

Järgnevas tabelis on loetletud Etherneti toega seadmed ja ruuterid, mis on Nox uneuuringusüsteemi puhul 

valideeritud. Noxturnal saab vastu võtta, sünkroonida, kuvada ja salvestada signaale Etherneti toega 

seadmetest, kui need on ühendatud samasse võrku.  

RUUTERID, IP-KAAMERAD JA MIKROFONID 

Tüüp Katalooginumber 

Ruuter Trendnet PoE Ei ole kohaldatav 

Axis T8351, 3,5 mm mikrofon Ei ole kohaldatav 

Axis P3374, internetiprotokolli kaamera Ei ole kohaldatav 

TOETATAVAD LISASEADMED 

Tüüp Katalooginumber 

SenTec SDM Ei ole kohaldatav 

Resmed TxLink Ei ole kohaldatav 

Resmed AirsenseTM10 Ei ole kohaldatav 

Resmed S9TM Ei ole kohaldatav 

Resmed Aircurve Ei ole kohaldatav 
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Regulatiivne teave 

Töökorra testimine ja valideerimise kokkuvõte  

Nox uneuuringusüsteeme on testitud ja kontrollitud erinevates faasides, mis hõlmavad nii siseteste, kontrolli ja 

valideerimist kui ka välisteste, et tagada tooteohutus, tõhusus ja usaldusväärsus. Kujundust kontrolliti ja see 

kiideti heaks, sh anti kliiniline hinnang kogu kujundusprotsessi jooksul kooskõlas nõutud spetsifikatsioonide ja 

ettenähtud kasutusega.  

Ettevõttel Nox Medical on standardi ISO 13485:2016 (MDSAP) järgi sertifitseeritud kvaliteedijuhtimissüsteem 

kooskõlas järgmiste dokumentidega: meditsiiniseadmete direktiiv (MDD – nõukogu direktiiv 93/42/EMÜ, 

muudetud direktiiviga 2007/47/EÜ); Kanada – meditsiiniseadmete eeskirjad (Medical Devices Regulations) – 

osa 1 – SOR 98/282; Austraalia – ravitoodete (meditsiiniseadmete) eeskirjad (Therapeutic Goods (Medical 

Devices) Regulations), 2002, tabel 3, osa 1 (v.a osa 1.6) – täielik kvaliteedi tagamise protseduur (Full Quality 

Assurance Procedure); Jaapan – MHLW MO No 169 (2004), muudetud MHLW MO No 60 (2021); PMD-i akt ja 

USA – 21 CFR 820, 21 CFR 803, 21 CFR 806, 21 CFR 807 – alaosad A kuni D. 

Sümbolite ja lühendite kirjeldus  

PG  Polügraafia 

PSG  Polüsomnograafia 

 
 CE-tähistus näitab vastavust kohaldatavatele EL-i 

direktiividele. 

(01)15694311110255(8012)VVvvr

r(11)YYMMDD(10)ZZZZZZ 

 Unikaalne seadme identifikaator (UDI): rakenduse 
identifikaator (01) tähistab seadme identifikaatorit (DI) 
(s.t „15694311110255"), rakenduse identifikaator 
(8012) tähistab tarkvaraversiooni (s.t „VVvvrr"), 
rakenduse identifikaator (11) tähistab 
tootmise/valmistamise kuupäeva (s.t „YYMMDD", kus 
„YY" on tootmisaasta kaks viimast numbrit, „MM" on 
tootmiskuu ja „DD" tootmispäev) ja rakenduse 
identifikaator (10) tähistab partiinumbrit (s.t „ZZZZZZ") 

 

 Unikaalne seadme identifikaator (UDI) esitatuna 
rakenduse Noxturnal CD-l andmemaatriksina 

 
 Teave tootja kohta 

 
 Tootmiskuupäev 

 
 Partii number 
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  Katalooginumber/viitenumber 
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     Teave 

Käesolev kasutusjuhend on saadaval elektroonsel kujul kooskõlas komisjoni määrusega (EL) nr 207/2012, 9. 

märts 2012, meditsiiniseadmete elektrooniliste kasutusjuhendite kohta. See on elektroonsel kujul kättesaadav 

ka ettevõtte Nox Medical veebilehel: www.noxmedical.com. 

Elektroonilised versioonid on esitatud PDF-dokumentidena ja nende dokumentide avamiseks on vaja PDF-

lugejat. Tavaliselt on PDF-lugejad saadaval tasuta. Pidage kasutatava PDF-lugeja puhul silmas kohalduvaid 

süsteemi- ja riistvaranõudeid. 

Paberkandjal kasutusjuhendit saab tellida tasuta, saates e-kirja aadressile support@noxmedical.com. 
Paberkandjal koopia saadetakse 7 kalendripäeva jooksul. 
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Lisa 

Tuletatud vaikimisi signaalid  

Noxturnal arvutab tuletatud vaikimisi signaalid salvestatud lähtesignaalide abil. Tuletatud signaalid on mis 
tahes signaali statistilised või otsesed teisendused ja neid kirjeldatakse allolevas tabelis. 

Tuletatud 
signaal 

Lähtesignaal Kirjeldus 

Aktiivsus Gravitatsioon X 
ja gravitatsioon 
Y 

Patsiendi aktiivsuse/liigutuste ilmingud. Aktiivsussignaal 
arvutatakse töötlemata gravitatsioonisignaali (X- ja Y-telg) 
põhjal, mida mõõdetakse salvestistes Nox kolmemõõtmelise 
kiirendusanduriga. Mõõdetud gravitatsioonisignaal 
diferentseeritakse aja suhtes ja skaleeritakse õige 
skaleerimisfaktoriga, et luua tuletatud aktiivsussignaal. 

Helitugevus 
(dB) 

Helitugevus Logaritmilise skaalaga (detsibellides) helitugevuse signaal 

arvutatakse automaatselt töötlemata helitugevuse signaalist, 

mis on lineaarsel skaalal. Võrrand, mida signaali arvutamiseks 

kasutatakse on V_dB = 20 log(x/P_0), kus V_dB on 

helitugevus detsibellides, P on töötlemata helitugevuse 

signaal (mis on rõhusignaal ühikutes Pa) ja P_0 

võrdlushelirõhk, mille väärtus tarkvaras Noxturnal on P_0 = 

20 µPa.  

Kalibreeritud 
kõhu RIP 

Kõhu RIP  Kalibreeritud kõhu RIP-signaal arvutatakse iga kõhu RIP-
signaali väärtuse skaleerimisega vastava RIP K-signaali abil 
(tuletatud signaal). Voolusignaal luuakse automaatselt, kui on 
olemas nii kõhu RIP-signaal kui ka RIP K-signaal. 

Kalibreeritud 
RIP-vool 

Rindkere RIP Kalibreeritud RIP-vool arvutatakse rindkere RIP-signaalide ja 
kalibreeritud kõhu RIP-signaalide (tuletatud) summa 
tuletisest ning seda väljendatakse ühikuga V/s.  

Kalibreeritud 
RIP-summa 

Kõhu RIP ja 
rindkere RIP 

Kalibreeritud RIP-summa signaal arvutatakse rindkere RIP-
signaali lisamise teel kõhu RIP-signaalile pärast seda, kui 
viimane on skaleeritud RIP K-signaaliga.  

Õhuvool 
kanüülis 

Rõhk kanüülis Kanüüli õhuvoolusignaal, on kvalitatiivne signaal, mis on 
tuletatud ninakanüüli töötlemata rõhusignaalist ja mida 
väljendatakse ühikutes cmH2O. Ninakanüüli rõhusignaali 
madalpääsfiltreeritakse väärtusel 3 Hz ja seejärel tuletatakse 
kanüüli õhuvoolusignaal mittelineaarsest valemist.  

Norskamine 
kanüüliga 

Rõhk kanüülis Norskamissignaal (norskamine kanüüliga) tuletatakse 
kõrgpääsfiltreeritud ninakanüüli töötlemata rõhusignaalist 
või õhuvoolusignaalist.  

Otsmikusagara 
EMG  

E1–E3 ja E2–E4 Vasakpoolse otsmikusagara EMG signaal vastab 
võrdlussignaalile E1–E3 ja parempoolse otsmikusagara EMG 
signaal vastab võrdlussignaalile E2–E4 
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Õhuvoolu 
takistus 

Rõhk kanüülis Õhuvoolu takistuse signaal tuletatakse matemaatilise 
valemiga, mida kasutatakse sissehingamise tasasuse 
arvutamiseks.  

Südame 
löögisagedus 

EKG R-laine tuvastamise algoritm, mida kasutatakse EKG-signaalis 
südamelöökide tuvastamiseks. Hetke südame löögisagedus 
on järjestikuste südamelöökide vaheliste intervallide 
vastandväärus. Südame löögisageduse signaali ühik on l/min 
(lööke minutis). 

Maski rõhk Töötlemata 
rõhk 

Maski rõhu signaali arvutatakse seadmetes T3 ja A1, ent 
seadmete uuemates versioonides arvutatakse maski rõhku 
rakenduses Noxtural töötlemata rõhu signaali abil, kui maski 
rõhu kanal on salvestuse puhul lisatud seadmeprofiili. Maski 
rõhk peaks olema identne töötlemata rõhu signaaliga, ent 
erineva signaalitüübiga 

Nina rõhk Töötlemata 
rõhk 

Nina rõhu signaali arvutatakse seadmetes T3 ja A1, ent 
seadmete uuemates versioonides arvutatakse nina rõhku 
rakenduses Noxtural töötlemata rõhu signaali abil, kui nina 
rõhu kanal on salvestuse puhul lisatud seadmeprofiili. 
Töötlemata rõhu signaali kõrgpääsfiltreeritakse, et luua nina 
rõhu signaal. 

Asend Gravitatsioon X 
ja gravitatsioon 
Y 

Patsiendi asendi väljendus, millega saab eristada asendeid 
püsti, selili, kõhuli, paremal küljel ja vasakul küljel. 
Asendisignaal luuakse muutujate gravitatsioon X ja 
gravitatsioon Y abil ning see on keha pöörlemistelje nurk. See 
varieerub –180° kuni 180° ning on 0°, kui patsient on näoga 
ülespoole. 

PTT EKG ja 
pletüsmograafia 

PTT ehk pulsi edastamisaeg on ajaintervall EKG-l R-laine ja 
(oksümeetrist saadud) fotopletüsmograafiasignaali 
madalaimast väärtusest 50% tõusu vahel. 

Pulsilaine 
amplituud 

Pletüsmograafia Pulsi lainevormi amplituud (PWA) on signaal, mis näitab pulsi 
lainevormi (oksümeetrist saadud fotopletüsmograafiasignaal) 
piik-piik väärtust, mille puhul kasutatakse testimise ja 
hoidmise meetodit laine kestuse ajal. Ühik on k. 

RIP-summa Kõhu RIP ja 
rindkere RIP 

RIP-summa (V) arvutatakse kõhu RIP-signaali ja rindkere RIP-
signaali summana. 

RIP-vool Kõhu RIP ja 
rindkere RIP 

Vöö vool arvutatakse kõhu RIP-signaali ja rindkere RIP-
signaali summa tuletisest ning selle ühik on V/s. 

RIP K Kõhu RIP ja 
rindkere RIP 

Kõhu RIP-signaalist ja rindkere RIP-signaalist tegeliku 
hingamisvoolu veelgi täpsema hinnangu saamiseks tuleb 
kõhu RIP-signaal skaleerida kalibratsioonifaktori abil. See 
kalibratsioonifaktor on salvestatud kui tuletatud signaal K. K 
leitakse optimaalse väärtuse, mis annab parima 
korrelatsiooni tuletatud RIP-voolu ja kopsu võrdlusõhuvoolu 
vahel, otsimise teel. 
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RIP-faas Kõhu RIP ja 
rindkere RIP 

Kõhu RIP-vöö ja rindkere RIP-vöö vaheline faasierinevus. 
Faasisignaal jääb vahemikku 0–180°. RIP-faasi näidatakse kui 
signaali, mis on sünkroonitud kõhu RIP-vöö ja rindkere RIP-
vööga. 

RIP-induktiivsus 
ja kiire RIP-
induktiivsus 

Töötlemata RIP-
väärtused 

RIP-induktiivsuse signaale arvutatakse seadmetes A1, ent 
seadmete uuemates versioonides arvutatakse RIP-
induktiivsust rakenduses Noxtural kõhu töötlemata signaali ja 
rindkere töötlemata signaali abil. Töötlemata signaalidele, 
mis mõõdavad RIP-vööde resonantssagedust, rakendatakse 
siirdesignaal, et hinnata vööde induktiivsust. Iga RIP-
induktiivsuse signaali puhul on saadaval kaks versiooni, üks 
saadud väärtusel 25 Hz ja teine 200 Hz. 

RIP ja kiire RIP Töötlemata RIP-
väärtused 

RIP-signaale arvutatakse seadmetes A1 ja T3, ent seadmete 
uuemates versioonides arvutatakse RIP-signaale rakenduses 
Noxtural kõhu töötlemata signaali ja rindkere töötlemata 
signaali abil. Töötlemata RIP-signaalid kõrgpääsfiltreeritakse, 
et luua RIP-signaalid. Iga RIP-signaali puhul on saadaval kaks 
versiooni, üks saadud väärtusel 25 Hz ja teine 200 Hz. 

Võrdlus-EEG EEG-signaalid EEG võrdlussignaal on kahe või enama EEG sisendsignaali 
keskmine.  

Hingamiskiirus Kõhu RIP ja 
rindkere RIP 

Hingamiskiiruse signaal tuletatakse RIP-summa signaalist 
(tuletatud signaal). Hingamiskiirust kuvatakse 
hingetõmmetena minuti kohta ehk h/min. 

Seadistatud 
rõhk 

Maski rõhk Seadistatud rõhu signaal luuakse maski rõhu signaalist. See 
näitab kõige tavalisemat maski rõhku 5 sekundi jooksul. 

TcCO2 (Pa) TcCO2 Transkutaanselt CO2-seadmelt saadud signaal, mille ühik on 
torr. Uus TcCO2-signaal, mille ühik on Pa, arvutatakse 
skaleerimisfaktori 133,3 Pa/torr abil. 

Automaatanalüüsi ülevaade 

Rakenduses Noxturnal rakendatud automaatanalüüsile tehti kliinilise töökorra testimised, et demonstreerida 

ohutust ja tõhusust. Kliinilise töökorra testimised koosnesid uneuuringutest saadud eelkliiniliste andmete, mis 

olid juba eelnevalt kogutud ja manuaalselt hinnatud osana rutiinsest kliinilisest tegevusest ja 

retrospektiivanalüüsist. Kõik hindajad olid kvalifitseeritud polüsomnograafiatehnoloogid ja järgisid Ameerika 

Unemeditsiini Akadeemia (AASM) hindamisjuhiseid. Uuringuprotokoll hõlmas raporteeritud 

juhtumite/sündmuste eksporti olemasolevast manuaalsest hindamisest ja seejärel rakenduses Noxturnal 

nende samade kliiniliste andmetega automaatanalüüsi tegemist. Automaathindamise tulemused eksporditi ja 

neid võrreldi manuaalselt hinnatud andmete puhul saadud tulemustega.  Kliinilise töökorra testimise 

üldjäreldus on see, et rakenduse Noxturnal automaatanalüüsi tööriistad on hinnatud vastuvõetavaks rutiinse 

hindamisvahendina kliinilisel eesmärgil, nagu kirjeldatud allolevas tabelis iga analüüsi puhul.  

Automaatne analüüs kinnitati kliiniliste unesalvestuste põhjal täiskasvanud elanikkonnast.   
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Nimi, eesmärk, juhtumid, 

sündmused 

Kliiniline seisund Ülevaade 

Bruksismi analüüs  

Kliiniline eesmärk on parandada 
võimalike bruksismiga seotud 
sündmustega kooskõlas olevate 
EMG andmete hindamise 
tõhusust EMG abil mõõdetavate 
mälumislihaste liigutuste 
märgistamise teel, mille järel 
koolitatud tervishoiutöötaja need 
läbi vaatab ja kinnitab.  

Piirangud. Teadaolevalt hindab 
see analüüs bruksismi sündmusi 
üle ja umbes 42% automaatselt 
hinnatud sündmustest tuleb 
manuaalselt eemaldada. 
Automaatanalüüsi tulemused 
peab enne diagnoosi panemist 
alati üle vaatama sertifitseeritud 
tehnik või arst. 

Hinnatud indeks. Bruksismi 

episoodi indeks (BEI) – bruksismi 

episoodide arv ühe tunni une 

kohta. 

Lõualihaste kokkutõmbed une 

ajal. Lõualihaste kokkutõmbed 

(võimalikud bruksismiga seotud 

sündmused) klassifitseeritakse 

tooniliste (pideva 

kokkusurumisega kokkutõmbed) 

või faasilistena (korduvad 

lühikesed kokkutõmbed). 

Algoritm kasutab mälumislihaste 
EMG-signaali ja aktiivsussignaali. 
Mälumislihase ajutise suurenenud 
aktiivsuse perioodid leitakse ja 
neid hinnatakse hoogudena. Kui 
hinnatud hood sobituvad toonilise 
või faasilise bruksismi episoodide 
mustriga, hinnatakse neid 
vastavalt, nagu määratletud 
AASM-i juhistes. Bruksismi 
episoode eiratakse vaikimisi, kui 
need ilmnevad samal ajal 
patsiendi liigutustega, mida 
iseloomustab aktiivsussignaali 
tõus. 

PLM-i analüüs 

Kliiniline eesmärk on parandada 
perioodiliste jäseme liigutamise 
sündmuste hindamise tõhusust.  

Piirangud. Automaatanalüüsi 
tulemused peab enne diagnoosi 
panemist alati üle vaatama 
sertifitseeritud tehnik või arst. 

Hinnatud indeksid.  

Jäsemete liigutamise indeks (LMI) 
– jäsemete liigutuste arv ühe 
tunni une kohta. 

Perioodilise jäsemete liigutamise 
indeks (PLMS) – perioodiliste 
jäsemete liigutamiste arv ühe 
tunni une kohta. 

Jäsemete liigutamine une ajal. 
Perioodid une ajal, mis kestavad 
0,5–10 sekundit, mille puhul 
jäseme lihastoonus, mida 
tavaliselt mõõdetakse 
säärelihasel, tõuseb võrreldes 
algväärtusega. 

Perioodilised jäsemete 

liigutamised une ajal. Periood une 

ajal, mille jooksul toimub 

vähemalt 4 jäseme liigutamise 

sündmust 5–90-sekundiliste 

intervallidega. 

Jäsemete liigutamise algoritm 
kasutab vasaku jala ja parema jala 
EMG-signaale, et leida perioode, 
mil lihastoonus on tõusnud. Lisaks 
kasutatakse aktiivsussignaali, et 
tuvastada patsiendi aktiivsust. 

PLM-analüüs tuvastab suure 
lihasaktiivsuse või kineetilise 
aktiivsuse sündmuseid ning 
määratleb need LM-sündmustena 
(jäseme liigutamine). Neid 
kasutatakse samal ajal 
määramaks, kas mis tahes PLM-i 
(perioodilised jäseme 
liigutamised) sündmused 
esinevad. Analüüsis järgitakse 
AASM-i määratletud juhiseid. 
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Hingamiskiiruse analüüs 
(kalibreeritud RIP, kanüül)1  

1) Kliiniline eesmärk on 
parandada apnoede, hüpopnoede 
(kalibreeritud RIP-i, kanüüli abil) 
ja oksümeetriga saadud 
desaturatsioonisündmuste 
hindamist.  

Piirangud. Tulemused peab enne 
diagnoosi panemist alati üle 
vaatama sertifitseeritud tehnik 
või arst. 

Hinnatud indeksid. 

Apnoe-hüpopnoe indeks (AHI) – 
apnoede ja hüpopnoede arv ühe 
tunni une kohta 

Apnoe indeks (AI) – apnoede arv 
ühe tunni une kohta 

Hüpopnoe indeks (HI) – 
hüpopnoede arv ühe tunni une 
kohta 

Hapniku desaturatsiooni indeks 
(ODI) – hapniku 
desaturatsioonisündmuste arv 
ühe tunni une kohta 

2) Kliiniline eesmärk on 
parandada apnoede 
tsentraalseteks apnoedeks, 
segatüüpi apnoedeks või mitte 
kummakski klassifitseerimise 
tõhusust.  

Piirangud. Tulemused peab enne 
diagnoosi panemist alati üle 
vaatama sertifitseeritud tehnik 
või arst. 

Hinnatud indeksid. 

Tsentraalse apnoe indeks (CAI, 
ingl Central Apnea Index) – 
tsentraalsete apnoede ja 
hüpopnoede arv ühe tunni une 
kohta 

Segatüüpi apnoe indeks (MAI) – 
segatüüpi apnoede arv ühe tunni 
une kohta 

Une ajal esinevad apnoed: 10 
sekundit või kauem kestvad 
perioodid, mil patsient ei hinga. 

Une ajal esinevad hüpopnoed: 10 
sekundit või kauem kestvad 
perioodid, mil patsiendi 
hingamine on äärmiselt piiratud. 

Hapniku desaturatsioon une ajal: 
perioodid, mil hapnikuga 
küllastatus langeb patsiendi 
arteriaalveres võrreldes 
algväärtusega 3% või enam. 

Tsentraalsed apnoed une ajal: 10 
sekundit või kauem kestvad 
perioodid, mil patsient ei hinga ja 
respiratoorne pingutus puudub. 

Segatüüpi apnoed une ajal: 10 
sekundit või kauem kestvad 
perioodid, mil patsient ei hinga. 
Respiratoorne pingutus puudub 
perioodi alguses, ent esineb selle 
lõpus. 

 

1) Apnoe/hüpopnoe (AHI) 
algoritm kasutab olenevalt 
tehtavast analüüsist hüponoede 
hindamiseks võimaluse korral kas 
hingamiskanüüli kiiruse või 
respiratoorse kalibreeritud RIP-
kiiruse signaali ning võib kasutada 
EEG-s hinnatud sündmusi. 
Hinnatud EEG sündmused on une 
ajal esinevad manuaalselt 
hinnatud virgumised. Algoritm 
kasutab ka oksümeetriga 
mõõdetud SpO2-signaali, et leida 
desaturatsioonisündmused, mida 
kasutatakse hüpopnoede 
hindamiseks, ent algoritm ei 
hinda desaturatsioonisündmusi.  

AHI algoritm määrab, kas patsient 
hingab normaalselt, kas 
hingamine on äärmiselt piiratud ja 
tekib hüpopnoe või kas patsient ei 
hinga ja tekib apnoe. Kui 
hingamine on äärmiselt piiratud, 
siis algoritm otsib hüpopnoe 
hindamise eesmärgil virgumisi või 
vere hapnikuga küllastuvuse 
langust, mis on seotud hingamise 
vähenemisega. 

Desaturatsiooni (ODI) algoritm 
kasutab oksümeetri mõõdetud 
SpO2-signaali, et määrata vere 
hapnikuga küllastatuse taseme 
3% või suuremat langust. 

Analüüsis järgitakse AASM-i 
määratletud juhiseid. 

2) Apnoe klassifitseerimise 
algoritm kasutab hingamiskiiruse 
signaali ning lisaks kõhu ja 
rindkere respiratoorse 
induktiivsuse pletüsmograafia 
(RIP) signaale. 

Apnoe klassifitseerimise algoritm 
klassifitseerib hinnatud apnoed 
tsentraalseteks või segatüüpi 
apnoedeks, kui respiratoorne 
pingutus apnoe ajal puudub, või 
mitte kummakski 

 

1 Kaasab AHI ja ODI algoritmi ning apnoe klassifitseerimise algoritmi 
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Tsentraalse segatüüpi apnoe 
indeks (CMAI) – tsentraalsete ja 
segatüüpi apnoede arv ühe tunni 
une kohta 

Analüüsis järgitakse AASM-i 
määratletud juhiseid. 

 

Unestaadiumide analüüs 

Kliiniline eesmärk on parandada 
unestaadiumide hindamise 
tõhusust eesmärgiga hinnata 
kogu une aega.   

Piirangud. Automaatanalüüsi 
tulemused peab enne diagnoosi 
panemist alati üle vaatama 
sertifitseeritud tehnik või arst. 

Hinnatakse järgmisi sündmusi: 
unestaadium W (Wake (Ärkvel)), 
staadium N1, staadium N2, 
staadium N3 ja staadium R (REM) 

 

Unestaadiumide mustrit 

kasutatakse selleks, et analüüsida 

indiviidi und ja määrata 

uneprofiilis mis tahes 

kõrvalekaldeid, mis võivad viidata 

unehäiretele. 

Algoritm kasutab 
elektroentsefalograafia (EEG) 
signaale, elektrookulogrammi 
(EOG) signaale, aktiivsusignaale ja 
submentaalse elektromüograafia 
(EMG) signaali, et anda 
unestaadiumidele eelhinnang 
kooskõlas AASM-i juhistega.  

Algoritmi on rakendatud kunstlik 
närvivõrk. Mitmeid 
karakteristikuid arvutatakse EEG, 
EOG, aktiivsussignaali või 
submentaalse EMG põhjal ja 
sisestatakse närvivõrku, mis 
tagastab unefaasid 30-
sekundiliste perioodidena, et 
simuleerida viisi, mil inimestest 
hindajad unestaadiume hindavad. 

Virgumise analüüs 

Kliiniline eesmärk on parandada 
virgumise hindamise tõhusust 
eesmärgiga parandada 
hüpopnoede hindamist. 

Piirangud. Automaatanalüüsi 
tulemused peab enne diagnoosi 
panemist alati üle vaatama 
sertifitseeritud tehnik või arst. 

Hinnatakse järgmisi sündmusi: 
EEG-signaalides tuvastatud 
virgumised. 

Virgumised une ajal. 

EEG sageduse järsk nihe, mis 

kestab 3–10 sekundit pärast 10 

sekundit stabiilset und. Saadud 

virgumise indeksit kasutatakse 

uneprofiilis unehäirete 

esinemisele viitavate 

kõrvalekallete tuvastamiseks. 

Virgumisi arvestatakse 

hüpopnoede tuvastamise korral 

ning need on seotud apnoe-

hüpopnoe indeksiga (AHI). 

Algoritm kasutab 
elektroentsefalograafia (EEG) 
signaale ja elektrookulogrammi 
(EOG) signaale, et anda 
virgumiste eelhinnang kooskõlas 
AASM-i juhistega.  

Algoritmi on rakendatud kunstlik 
närvivõrk. Salvestatud töötlemata 
EEG, EOG ja EMG signaalid 
sisestatakse kunstlikku 
närvivõrku, mis tagastab 
sündmused, mille puhul esinevad 
virgumised, et simuleerida viisi, 
mil inimesed hindavad virgumisi. 

Nox BodySleep-analüüs 

Kliiniline eesmärk on saada veel 
täpsem kodus tehtava uneuuringu 
uneaja hinnang ärkvel olemise 
õigesti klassifitseerimise teel. 

Piirangud. Automaatanalüüsi 
tulemused peab enne diagnoosi 
panemist alati üle vaatama 
sertifitseeritud tehnik või arst. 

Hinnatakse järgmisi sündmusi: 
unestaadium ärkvel, unestaadium 
NREM ja unestaadium REM 

Uneaega kasutatakse mõõdikuna 

AHI (apnoe-hüpopnoe indeks) 

arvutamiseks une ajal ja seda võib 

kasutada une kestuse 

hindamiseks, et määrata 

uneprofiilis mis tahes 

kõrvalekalded, mis võivad viidata 

unehäiretele. 

„Nox BodySleep" on 
tehisintellekti (AI, Artificial 
Intelligence) meetod, mida 
kasutatakse 30-sekundiliste 
perioodide klassifitseerimiseks 
staadiumitena REM-uni, NREM-
uni ja ärkvel. See kasutab 
respiratoorse induktiivsuse 
pletüsmograafia (RIP) signaale ja 
aktigraafiat, et mõõta aju oleku 
muutuse mõju kehale ning hindab 
nende signaalide alusel 
unestaadiume. 



rakenduse Noxturnal kasutusjuhend 

   

~ 86 ~ 

SAS-i unestaadiumide analüüs 

Kliiniline eesmärk on parandada 
unestaadiumite hindamise 
tõhusust eesmärgiga hinnata 
kogu une aega. 

Piirangud. Automaatanalüüsi 
tulemused peab enne diagnoosi 
panemist alati üle vaatama 
sertifitseeritud tehnik või arst. 

Hinnatakse järgmisi sündmusi: 
unestaadium W (Wake (Ärkvel)), 
staadium N1, staadium N2, 
staadium N3 ja staadium R (REM) 

Unestaadiumide mustrit 

kasutatakse selleks, et analüüsida 

indiviidi und ja määrata 

uneprofiilis mis tahes 

kõrvalekaldeid, mis võivad viidata 

unehäiretele.  

 

Algoritm kasutab 
elektroentsefalograafia (EEG) 
signaale, elektrookulogrammi 
(EOG) signaale ja otsmikusagara 
elektromüograafia (EMG) 
signaale, et anda erutuvuse 
eelhinnang kooskõlas AASM-i 
juhistega. 

Algoritmi on rakendatud kunstlik 
närvivõrk. Salvestatud töötlemata 
EEG ja EOG signaalid sisestatakse 
kunstlikku närvivõrku, mis saadab 
tagasi unestaadiumid 30-
sekundiliste perioodidena, et 
simuleerida viisi, mil inimesed 
hindavad unestaadiume. 

 

SAS-i virgumise analüüs 

Kliiniline eesmärk on parandada 
virgumise hindamise tõhusust 
eesmärgiga parandada 
hüpopnoede hindamist. 

Piirangud. Automaatanalüüsi 
tulemused peab enne diagnoosi 
panemist alati üle vaatama 
sertifitseeritud tehnik või arst. 

Hinnatakse järgmisi sündmusi: 
EEG-signaalides tuvastatud 
virgumised. 

Virgumised une ajal. 

EEG sageduse järsk nihe, mis 
kestab 3–10 sekundit pärast 10 
sekundit stabiilset und. Saadud 
virgumise indeksit kasutatakse 
uneprofiilis unehäirete 
esinemisele viitavate 
kõrvalekallete tuvastamiseks. 
Virgumisi arvestatakse 
hüpopnoede tuvastamise korral 
ning need on seotud apnoe-
hüpopnoe indeksiga (AHI). 

 

Algoritm kasutab 
elektroentsefalograafia (EEG) 
signaale, elektrookulogrammi 
(EOG) signaale ja otsmikusagara 
elektromüograafia (EMG) signaali, 
et anda virgumiste eelhinnang 
kooskõlas AASM-i juhistega. 

Algoritmi on rakendatud kunstlik 
närvivõrk. Salvestatud töötlemata 
EEG, EOG ja EMG signaalid 
sisestatakse kunstlikku 
närvivõrku, mis tagastab 
sündmused, mille puhul esinevad 
virgumised, et simuleerida viisi, 
mil inimesed hindavad virgumisi. 

 

 


